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This is the user guide for Viz World Client and Server.

This guide is designed to fit people with no or little experience in using Viz World, and aims to
help new users become familiar with the system.

Copyright © 2019 Vizrt Page 9
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1 Related Documents

For additional information, see the following documents:

Viz World Classic User Guide: Contains information on how to create map templates using
Viz World Classic.

Viz World Plug-ins Guide: Contains information on how to use the Viz World plug-ins.

Viz Artist User Guide: Contains information on how to create graphics scenes and
animations in Viz Artist.

Viz Engine Administrator Guide: Contains information on how to install the Viz Engine
software and supported hardware. Viz Engine is the output engine used for playout of
graphics, video, images, SDI sound and sound effects.

Viz Trio User Guide: Contains information on how to create real-time character generated
content based on templates and how to play out pages in shows based on these templates..
Viz Pilot User Guide: Contains information on how to create content based on templates and
how to play out elements in playlists based on these templates.

Viz Multichannel User Guide: Describes how to install, configure and use Viz Multichannel.
Viz NLE Administrator Guide: Contains information on how to use your graphics in a non-
linear editing tool.

Viz Weather User Guide: Contains information on how to create real-time generated weather
information and interactive shows using branded maps.

For more information about all of the Vizrt products, visit:

www.vizrt.com
Vizrt Documentation Center
Viz University

Copyright © 2019 Vizrt Page 10


http://docs.vizrt.com/viz-world.html
http://docs.vizrt.com/viz-world.html
http://docs.vizrt.com/viz-artist.html
http://docs.vizrt.com/viz-engine.html
http://docs.vizrt.com/viz-trio.html
http://docs.vizrt.com/viz-pilot.html
http://docs.vizrt.com/viz-multichannel.html
http://docs.vizrt.com/viz-nle.html
http://docs.vizrt.com/viz-weather.html
http://www.vizrt.com/
http://documentation.vizrt.com/
https://www.vizrt.com/community/viz-university

Viz World User Guide - 17.0

2 Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

See Also

- About Viz World

Copyright © 2019 Vizrt Page 11
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Introduction

This is the user guide for Viz World Client and Server.

This guide is designed to fit people with no or little experience in using Viz World, and aims to
help new users become familiar with the system.

Related Documents

For additional information, see the following documents:

Viz World Classic User Guide: Contains information on how to create map templates using
Viz World Classic.

Viz World Plug-ins Guide: Contains information on how to use the Viz World plug-ins.

Viz Artist User Guide: Contains information on how to create graphics scenes and
animations in Viz Artist.

Viz Engine Administrator Guide: Contains information on how to install the Viz Engine
software and supported hardware. Viz Engine is the output engine used for playout of
graphics, video, images, SDI sound and sound effects.

Viz Trio User Guide: Contains information on how to create real-time character generated
content based on templates and how to play out pages in shows based on these templates..
Viz Pilot User Guide: Contains information on how to create content based on templates and
how to play out elements in playlists based on these templates.

Viz Multichannel User Guide: Describes how to install, configure and use Viz Multichannel.
Viz NLE Administrator Guide: Contains information on how to use your graphics in a non-
linear editing tool.

Viz Weather User Guide: Contains information on how to create real-time generated weather
information and interactive shows using branded maps.

For more information about all of the Vizrt products, visit:

Www.vizrt.com

Vizrt Documentation Center
Vizrt Training Center

Vizrt Forum

3.2 Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

See Also

About Viz World
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4 About Viz World

For many years Viz World Classic (formerly called Viz Curious Maps) was the broadcast industry’s
number one tool for the creation of branded 2D maps and geographic animations.

Now Viz World takes this to a new level by adding support for real-time 3D maps and adding the
option to extend it to a client-server solution.

Viz World takes branded map imagery and provides it to different clients that are embedded within
Vizrt's control applications like Viz Trio and Viz Pilot. Templates created within Viz World can also
be accessed by Viz Weather, Viz Artist, and even NLE systems.

This tight integration allows users to seamlessly create branded, animated maps and add them to
graphic templates or insert them directly into a 3D scene. In addition, high-resolution satellite
imagery from around the world can instantly be browsed, downloaded and incorporated.

Viz World Client (WoC) integrates Viz World’s mapping ability and database into Viz Artist and Viz
Engine graphics. By utilizing a set of geographic referencing plugins and the maps produced by
WoC, the creation of location based graphics using maps, 3D objects, texts, and so on, is
seamless.

WoC includes a set of Viz Artist plugins and the Viz World World Map Editor (WME). The editor is
integrated into Vizrt products, simplifying production and control of the graphics.

The WoC also includes the Map Designer for creating map templates on-the-fly, as well as the Map
Builder for creating animated scenes with single or multiple destinations.

Usage of WoC clients requires one or more Viz World Servers (WoS) installed, running and
connected to the network. WoS is a software module used for creating template based maps and
managing client requests. All the map styles, map projects and designs are stored on the server.
The server’s license determines the number of concurrent client connections and the available data
sets.

This section contains information on the following topics:

- Workflow
New Features

4.1 Workflow

The basic workflow from design of templates to playout is as follow:

1. First step of the process is to create a single (or multiple) in-house map project template
that sets the look and feel of all the produced maps later in the production chain. This is
done using Viz World Classic (VWC), selecting for example style and color on the selected
map area, type of border lines, label fonts and available marker icons.

2. The designed map project template is made available to users of Vizrt client software via the
Viz World Server (WoS).

3. A graphic designer creates Viz scenes that include maps, based on the same map project
template now residing on the Viz World Server. The designer has the option to create 2D or
3D labels and markers inside Viz, instead of using the ones exposed in Viz World Classic.

4. Based on the Viz scenes, graphical templates can be made for other Vizrt applications.

5. An editor opens a template, from for example the Viz Pilot or Viz Weather system, and
creates a map to fit the main news or weather story of today.

Copyright © 2019 Vizrt Page 13
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4.2 New Features

@ Map Editor (WME) - VizDefProject.tpl
] 9 Natural Ear
P ]

el o) () 10 Cosi - el Cylindrical Equidistant Mercator

Locator Preview

s >
Kreith

§ | cameqLizur

20

Google Maps integration
Google tiles based on predefined profiles or user profiles

Google search engine

UAC awareness
On a clean install, all user files are saved under C:\ProgramData\vizrt\VizWorld
When upgrading, user files are saved in the old location
VizWorldUACMigrationAssistant.exe can be found in the program folder to help the
migration to UAC aware.

Copyright © 2019 Vizrt Page 14
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5 Requirements

This section describes the prerequisites such as the licensing, software and hardware
requirements.

This section contains information on the following topics:

License Requirements
Software Requirements
Server System Requirements
Ports and Connections

See Also

Installation
Configuration

5.1 License Requirements

The following licenses are needed to run Viz World Server and Viz Engine:

- A USB dongle license for Viz World Server
- A USB dongle license for Viz Engine

If you are using the old green Sentinel dongles, please update your Sentinel Super Pro drivers to
the latest version. If you are using the Aladdin dongles (usually blue), please install the Aladdin
Hard Lock driver.

Aladdin dongle driver is available in "Installers" folder in the installation directory, which is by
default in the following path:

32 bit: C:\Program Files (x86)\vizrt\Viz World\Installers
64 bit: C:\Program Files\vizrt\Viz World\Installers

& Note: Viz World Server is a feature included in the license file. If the server has
additional features enabled, make sure the new license file covers those features as
well.

5.2 Software Requirements

To run the Viz World Client and Server, the following software is required:

- Viz World Client (Map Editor) 17.0
- Viz World Server 17.0 - It is recommended to install the server on a separate machine.
- Viz World database 17.0

Microsoft Visual C++ 2010 Redistributable Package

Copyright © 2019 Vizrt Page 15
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Microsoft .NET Framework 4 or later is required for the Map Designer, Map Builder and
World Map Editor.

For graphics design the following software and version numbers are needed.
- Viz Artist 3.6 or later
For a newsroom/control room the following application versions are required:

- Viz Trio 2.12 or later
- Viz Pilot 5.7 or later
Media Sequencer 1.23 or later

5.3 Server System Requirements

Minimum configuration:

- CPU: Intel Core2 CPU, 2.0 GHz
Memory: 4GB
Hard disk space: A full installation requires about 2 GB free disk space. Optional data
packages will require between 4GB to 500GB free disk space.

Recommended configuration:

- CPU: 2 x Intel i7 CPU (or equivalent Intel Xeon processor)

Memory: 16GB
Hard disk space: A full installation requires about 2GB free disk space. Optional data
packages will require between 4GB to 1000GB free disk space.

& Note: When more than one server will be run on a single machine it is necessary to
use the recommend system configuration described above. See Server Allocator
Configuration.

Server Operating Systems:

- Microsoft Windows 7/10 (64-bit, 32-bit)
- Windows Server 2008R2/2012R2/2016

Also note that fast and multiple CPU cores are the most important component of WoS.

5.4 Ports And Connections

The following describes all connections and default listening port numbers that are important for
any system/network administrator to know of. However, it is, if possible, recommended to run the
system on a network without firewalls.

102 (TCP) is a Viz World Server listener port for Viz World Client connections when Server Allocator
is not in use or only has one Viz World Server running.

103 (TCP) is a Viz World Server listener port for configuration tool connections to the first Viz
World Server instance (as configurations are controlled by the first server instance).

10100 (TCP) is a Server Allocator listener port for Viz World Client connections, and is only used in
order for clients to get connection details about Viz World Server(s). The first client connection will
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always be diverted to port 102. In case of Multiple server instances port numbers are assigned
according to a predefined schema. In case there is no Server Allocator, Viz World Server will itself
switch to port 102.

10100 (UDP) is a Viz World Server listener port for Server Allocator communication.
10200 (UDP) is a Server Allocator listener port for Viz World Server communication.

Both UDP ports are internal ports used between the servers.

5.4.1 Multiple server instances

If a machine is running multiple Viz World Server instances every extra instance (second and
above) opens other ports by this formula:

- Viz World Server listener port (TCP): 10100 +ID - 1.
- Server Allocator listener port (UDP): 10200 + ID - 1 (this is an internal port between servers)
(where ID indicates the instance, e.g. 3rd server, ID = 3).

If four Viz World Server instances are configured, the following listener ports will be used:

102 (TCP): 1st instance

10101 (TCP): 2nd instance

10102 (TCP): 3rd instance

10103 (TCP): 4th instance

10100 (TCP) : Viz World Client(s) connection to the Server Allocator.
103 (TCP): Configuration tool connection to the Viz World Server.

Internal ports used by Server Allocator and Viz World Server(s) to communicate between
themselves:

10100 (UDP): Server Allocator
10200 (UDP): 1st instance
10201 (UDP): 2nd instance
10202 (UDP): 3rd instance
10203 (UDP): 4th instance

Copyright © 2019 Vizrt Page 17



Viz World User Guide - 17.0

6 Installation

This section describes how to install and remove the components of Viz World Server (WoS) and
Viz World Client (WoC).

This section contains information on the following topics:

Downloading the software
Installing Viz World Server
Installing Viz World Client
Installing Photoshop Plugin

6.1 Downloading The Software

Whilst you have an active map support contract, you have a personal login to the Vizrt FTP server
(first year support is included).

Download the software from the Vizrt FTP at ftp://download.vizrt.com/ under the Viz World
folder.

& Note: You will need to use an FTP Client to access this site and not a regular web
browser.

Please use the FTP server to find the latest Vizrt software releases, documentation, help
files, drivers and more. You can also use the FTP to upload and exchange files with Vizrt

6.2 Installing Viz World Server

& Note: Before starting an installation, ensure that the Viz World Server USB license dongle
and license file are available. unless the license is MAC address based license then only
license file is required.

The Viz World Data and Viz World Server installers are required.

This section contains information on the following topics:

- To install Viz World Data
- To install Viz World Server and Classic

6.2.1 To install Viz World Data

. Start the Viz World Data installer VizWorldDb17.0.0.msi

Click Next

3. Select the features to install, where "Combination" and "Relief" are mandatory features and
Extras is optional (Extras feature contains UK MapData with Metropolitan counties of
England to be imported as street data if required)

4. Click Install to begin the installation

5. Click Finish

N —
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6.2.2 To install Viz World Server and Classic

Before Viz World Classic is installed, you have To install Viz World Data

& Note: Exit all Windows programs before running the Setup Program.

Start the Viz World Server installer VizWorld17.0.0.msi

Click Next

Read the End-User license agreement and accept it

Click Next

Select destination directory, and click Next. Default installation directory is:
32 bit: C:\Program Files (x86)\Curious Software\Curious World Maps
64 bit: C:\Program Files\vizrt\Viz World

Click Install to start the installation

Click Finish

Optional: Install QuickTime if it is not previously installed.
If a newer version of QuickTime is installed the installation will be stopped.

uIThWN —

©NO

& Tip: If you do not already have QuickTime installed you can download the
installer from the Apple website.

6.3 Installing Viz World Client

Viz World Client (WoC) is used to integrate maps and geographical data into scenes. Its
components are the Map Designer , Map Builder, World Map Editor, Map Editor Classic and design
plugins.

Viz World Client (WoC) installs new components in the following places (if Viz Engine is already
installed).

- Viz 3.x (C:\Program Files\vizrt\viz3)
- Common files (C:\Program Files\vizrt\common) (components are installed here only if Viz
Engine is not installed)
Select the installer settings that correspond to your Viz Engine (ie. 32 or 64-bit).

Use the bundle installer (which includes both 32 and 64-bit) for easier installation of Viz Trio/Viz
Pilot/Viz Weather clients when combining with a 64-bit Viz Engine.

There are two ways of installing the client; a standard installation which requires the user to
perform and confirm all actions during the installation, or a silent installation that enables the user
to install Viz World Client without using the installer’s dialog boxes.

This section contains information on the following topics:

- To install Viz World Client
- To install/uninstall Viz World Client in silent mode
- To remove Viz World Client
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6.3.1 To install Viz World Client

Double-click the VizWorldClient_17x.x.x.msi installer to start the installation
In the Setup Type window, select Typical, and click Next

Select the Yes, | want to restart my computer now option

Click Finish.

A WN—

6.3.2 To install/uninstall Viz World Client in silent mode
Viz World Client 64bit silent install:
WHEN Viz ENGINE 64bit IS ALREADY INSTALLED:

- Command: msiexec /i <path to Viz World Client installer file> /passive (This will install Viz
World Client 64bit including Viz files to "C:\Program Files\Vizrt\Viz3\plugin" and design
client, help files and API files to "C:\Program Files\Vizrt\Common")

Example: msiexec /i C:\VizWorldClient_x64_17.0.0.14934.msi /passive

- Command: msiexec /i <path to Viz World Client installer file> /passive ADDLOCAL=ALL (This
will install Viz World client 64bit including Viz files to "C:\Program Files\Vizrt\Viz3\plugin"
and all client files (Design-Admin-Traffic), help files and API files to "C:\Program
Files\Vizrt\Common\Maps")

Example: msiexec /i C:\VizWorldClient_x64_17.0.0.14934.msi /passive ADDLOCAL=ALL

- Command: msiexec /i <path to Viz World Client installer file> /passive ADDLOCAL=ALL
REMOVE=Admin (This will install Viz World client 64bit including Viz files to "C:\Program
Files\Vizrt\Viz3\plugin" and client files (Design-Traffic), help files and API files to "C:
\Program Files\Vizrt\Common\Maps")

Example: msiexec /i C:\VizWorldClient_x64_17.0.0.14934.msi /passive ADDLOCAL=ALL
REMOVE=Admin

REMOVE key values are :

"Design" (not to install Map Design Client, OSM Downloader, Style editor)

"Admin" (not to install Map config client, World server Monitor, Maps Name Editor, GeoFeeds
Configuration, CMS Test Client)

"Traffic" (not to install FetchTraffic and TotalTrafficConfigurator)

"H" (not to install help files)

"A" (not to install API files)

- Command: msiexec /i <path to Viz World Client installer file> /passive ADDLOCAL=ALL
VIZFOLDER=<path> (This will install Viz World client 64bit including Viz files to the specified
path and client files (Design-Admin-Traffic), help files and API files to "%\Program
Files\Vizrt\Common\Maps")

Example: msiexec /i C:\VizWorldClient_x64_17.0.0.14934.msi /passive ADDLOCAL=ALL
VIZFOLDER=c:\temp

WHEN Viz ENGINE 64bit IS NOT ALREADY INSTALLED:
Same as when Viz Engine 64bit is installed except that Viz files will not be deployed.

Viz World Client 32bit silent install:
WHEN Viz ENGINE 32bit IS ALREADY INSTALLED:

Same as Viz World Client 64bit installer, except that installation directory is "C:\Program Files
(x86)\Vizrt\Common\Maps"

WHEN Viz ENGINE 32bit IS NOT ALREADY INSTALLED:
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Same as when Viz Engine 32bit is installed except that Viz files will not be deployed
Viz World Client 64bit/32bit silent uninstall:

Command: msiexec /x <path to Viz World Client installer file> /passive

& IMPORTANT! Any unexpected events during silent installation may result in a failure.
Unexpected events can be, for example, needing to restart the computer or Viz not
installed in the default path.

6.3.3 To remove Viz World Client

1. Start the Client installer by either:
a. Start Add or Remove Programs and click the Change/Remove button next to the Vizrt
Viz World Client item, or
b. Run the VizWorldClient_x.x.x.x.msi installer file
2. Select the Remove Installed Files option and click Next
3. Click Finish

6.4 Installing Photoshop Plugin

The Viz World Photoshop Plugin is used to integrate Viz World and Adobe Photoshop files. Maps
created with the Photoshop plugin will create a new file with separate layers for every feature and
detail on the map.

The scripts which are installed as part of the plugin are used to:

- Configure the different settings of the Photoshop Plugin.
- Open Map Editor Classic to select the desired map.
- Create the final Adobe Photoshop file and layers, based on the selection and configuration.

6.4.1 Installed Files

The Photoshop plugin is installed under:

C:\Program Files\Adobe\Photoshop\Plug-ins\Import-Export Or
C:\Program Files (x86)\Adobe\Photoshop\Plug-ins\Import-Export
The file that is installed is

+ VizrtMapImport.8ba
The scripts are installed under:

C:\Program Files\Adobe\Photoshop\Presets\Scripts or
C:\Program Files (x86)\Adobe\Photoshop\Presets\Scripts
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® Important
Newer Versions of Adobe Photoshop (like CC 2017) install in a different directory than c:
\Program Files\Adobe\Photoshop. It might be required to copy the whole content of c:
\Program Files\Adobe\Photoshop to the real Photoshop Installation like C:\Program
Files\Adobe\Adobe Photoshop CC 2017

6.4.2 To install the Photoshop Plugin

1. Install Viz World Client (see Installing Viz World Client)
2. Double click the vizWorld-Photoshop-xxx.msi

& Note: In order to support Adobe Photoshop 32 bit and 64 bit, there are two different
installers, (i.e. x86 and x64). Ensure you have the installer which matches your
Photoshop version, also a bundle installer is available for installing required
dependencies, and provides the option to choose which Photoshop plugin version to
install (i.e. x86 and x64).

3. Click Next

6.4.3 To configure the Photoshop Plugin

1. Launch Adobe Photoshop
2. Click File->Script - Viz World Setting
3. Enter the machine name of your Viz World Server

@® The configuration file being used is located in C:\Program
Files\vizrt\Maps\Photoshop if you need to edit the configuration manually.
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7 Configuration

This section describes how to configure Viz World Server, Viz Engine, and Viz Artist, as well as
some useful cache settings.

This section contains information on the following topics:

Server Configuration
Viz Engine/Artist Configuration
Cache Configuration

7.1 Server Configuration

The Server Configuration Tool is used to remotely configure the Viz World Server settings.

The configuration tool is included when Installing Viz World Server and can also be installed when
Installing Viz World Client. From the Windows start menu, select:

Server: Programs > Vizrt > Viz World Server > Server Configuration tool
Client: Programs > Vizrt > Viz World Client > Server Configuration tool

& Caution: The server is locked when using the configuration tool; hence, no client
connection will be accepted.

& Note: When using Server Allocator with multiple servers, each machine running the
servers must be configured separately. Use the configuration tool to connect to all
the servers and configure them.

This section contains information on the following topics:

User Interface
Template
Locations
Logins

License

Maps
Standalone Clients
Symbols
Timeouts
Proxy Server
Server Logging
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7.1.1 User Interface

@ Viz World Server Configuration Tool = O x

File View

Map Server: Connect Disconnect

+ Template
Locations
(- Logins
Guest
L. Users
- License
= Maps
- Database
- Database Features
- Disputed Regions
Default Projection
-~ Map Legend
- Locations
User DEMs
- Attribution
- Bing
- Digital Globe
- Google Maps
- Display
- Street Admin
- Imported Data
- Roads & Chicklets
- Plugins
Place Finder
£ Standalone Clients
Export Folder
Export Formats
- Symbaols
- Timeouts
- Proxy Server
- Server Logging

Ready
The server configuration window has two panes, the left pane displays the configuration sections
and the right pane displays the parameters of the selected section.

Before using the configuration tool, a connection to the server must be established. When a
connection is established, the Connect button will be disabled and the Disconnect button will be
enabled. The right pane will be populated with the parameters of the selected section.

When connected, the main configuration window appears as follows:

send Logoff Message Force Logoff Restart

Send Logoff Message: Sends a logoff request will to the server. The server will end the
session normally.

Force Logoff: Sends a logoff message to the server, ending the session immediately.
Restart: Restarts the server instantly. The configuration tool will be disconnected from the
server. When a Map Server is defined, and more than one instance of Viz World Server is
defined, all instances will be restarted.

& Note: Most configuration changes requires a server restart before they take effect.
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& Caution: When Viz Maps Server Config tool is running the server is locked. No client
connection will be accepted.

To connect to the server

Enter the server name or IP address in the Map Server field, and click Connect.

7.1.2 Template

Project Template

The project template is used to specify the image size
and available styles for all dients, You should create
a template file using Viz World Classic,

C:'ProgramDatavizrtiyiz '-.".n'-:urll:l'n,'n,F‘rl:ujeci Browse. ..

Project Template: Defines the default project that will be used by the server when initially
asking for a map or the client requests a project that does not exist.

7.1.3 Locations

The Locations section defines the path to required software components.

Locations for the installed components.,

Root | C:\ProgramDatavizrtiviz Waorld', | Browse. ..

Licenses | C:\ProgramDatalVizrt\viz 'L"'.I'EIF|E|'I,'I,|.iEEI‘|SES'I,EI.IFiE| Browse. ..

Settings |C:'|,F‘r|:|gramData'|,'u'izrt‘|,'u'iz World\\Settings | Browse. ..

KML |C:'|,F‘r|:|gramData'|,'l.-'izrt'|,'l.-'iz Worldy\ML | Browse. ..

Root: Defines the installation folder.
Licenses: Defines the license file(s) folder.
Settings: Defines the path to the settings folder.

/.1.4 Logins

The Logins > Users section displays the users configured on the server. Viz World Clients use the
pre-defined Guest user to log on to the server.
The Logins > Guest screen is used to set some of the guest user permissions.

& Note: Users are added and removed from Viz World Classic only.
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Allow Guest
Allow Guest Projects

GuestProject | c.\program Files\Curious Software\Curious Wi -
Folder a | [ Browse...
GuestKML | . : : : : .'. "
. C:'\Program Files\Curious Software\Curious Wt | |Browse. ..

Allow <user name>: Allows the user to connect to the server when running WME or Viz.

Allow <user name> Projects: Allows the user to access projects defined in the <user name>
Project Folder.

<user name> Project Folder: Defines the path to a folder containing the user’s projects.

7.1.5 License

Thu Feb 11 11:37:33 2010 A

Viz CM5 10.0.0,2554 RC (Map DB v10.0)
00226490 PC [ License key: A392F PC
Hardware key found correctly.

537 gueries sent to dongle, w
£ >
.
L
£ >
Add License From File... ] [ Dump License Info... l

The License section displays information about the current server license and enables the user to
load other license files.

& Note: If the license is not valid, the server will not start.

Add License From File: Opens a file browser that enables the user to load additional license
features from a different license file and to add it to the system. After a new license file is
added, the Apply button is enabled.

Dump License Info: Saves the license information, that is displayed in the text box, to a file.
Apply: Applies the new license information to the system’s license file.

To manually add a license file
Locate the License file (*.lic), copy and paste it into the Licenses folder:

32 bit: C:\ProgrambData\Curious Software\Curious World Maps\Licenses
64 bit: C:\ProgramData\vizrt\Viz World\Licenses
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To add a license file using the Maps Server Configuration tool

Start the server configuration tool.

Select the License section.

Click the Add License From File ... button.

Locate and select the file and click Open to add the new license file.
The license becomes visible in the Edit License window.

5. Click Restart to start the server with the new license.

A WN—

To add a license file using Viz World Classic

Viz Wordd Classic is unable to run as you do not appear to have a cument, valid
bcenze.

To purchiass a kcanse for this software. or request a timedimited
EVALUATION bcense enabling all features, please vist us at
WWW . ViZzr.com

Ehemet ID:  [a4badbfdd2 PC

" . |Uicenss key: B3ACT143B653C Viz
Hardwers Key: Hardveare key found comecity

Licensa .

When starting Viz World Classic without a license, a window appears informing that a valid license
cannot be found.

1. Start the Viz World Classic application
2. Click the License button to open the Software License window
3. Click the Edit License File ... button to open the Edit License window
4. Click the Add License from a File ... button to browse for the License file (*.lic)
5. Select the License file and click Open
The license becomes visible in the Edit License window
6. Click OK to save the License. The license is saved to the License folder
7. Exit the application and run the Viz World Server.
7.1.6 Maps

The Maps section is used to define the following general map settings:

Database

Database Features
Disputed Regions
Default Projection
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Map Legend
Locations
User DEMs
Attribution

To position the attribution image
Bing

Digital Globe
Proxy Settings
Display

Street Admin
Imported Data
Plugins

Place Finder

Database

Database | Cambination Database [v]

Shared User Map Data

IIser Map Details and Alternate Mames are loaded from
text files created with Curious World Maps.

IIser Map Details are added using the Mew Detail button

C:\Program Files\Curious Software\Cu

Alternate Mames for map details can be set in the Map
Details Properties tab

C:\Program Files\Curious Software\Cu

Abbreviations

C:\Program Files\Curious SoftwareCu

Database: Select the data base type. It only displays location entries that are visible in the
map area.
Shared User Map Data: Defines the source of data used by the database.
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Database Features

Accented characters
() Remove non latin-1 accents on database load

") Remove non latin-1 accents if not supported by font
(¥ Display Mull character where font does not support accented character

Database Features

The detailed databases contain additional features from sources that
may not accurately align with the base data. Reset this switch to hide
these features.

IUse all data sources for searching
Accented characters: Handles accent characters in labels such as ~ in Espafa.

DataBase Features: Defines whether the WME search tool will use additional databases in the
system or only the Viz World database.

Disputed Regions

Reqgion | Arunachal Pradesh V
Configuratior | Default |

di-:.a ey Arunachal Prades

Region: Displays a list of the disputed regions defined in the system. Select one of the
disputed regions to be configured.

Configuration: Displays a list of region and border options related to the selected disputed
region in the Region parameter. Select an option from the list and the graphic display will
change according to the selected option.
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Default Projection

Default projection for new map layers

Cylindrical Equidistant w

|in-projected. Longitude and
| atitude are mapped directhy
into x, ¥ coondinates.

Supports Geotiff export

Sets the default projection for when a client opens a template that does not have a map layer. The
following options can be set:

Globe: Sets a globe projection.

Cylindrical Equidistant: Sets an unprojected map. Longitude and latitude are mapped directly
into X and Y coordinates.

Miller Equidistant (37 30): Relative distances are correct. Angles are correct around 37
degrees 30 minutes North.

Miller Equidistant (43): Relative distances are correct. Angles are correct around 43 degrees
North. Minimum scale distortion over continents.

Miller Equidistant (50 28): Relative distances are correct. Angles are correct around 50
degrees 28 minutes North.

Gall Isographic: Relative distances are correct. Angles are correct around 45 North.

Lambert Cylindrical Equal Area: A cylindrical equal area projection which uses the equator as
the parallel of no distortion.

Behrman Cylindrical Equal Area: A cylindrical equal area projection which uses 30 degrees
North as the parallel of no distortion.

Tristan Edwards: A cylindrical equal area projection which uses 37 degrees 38.3 minutes
North as the parallel of no distortion.

Peters: De-emphasizes area exaggeration in high latitudes.

Gall Orthographic: A cylindrical equal area projection which uses 45 degrees North as the
parallel of no distortion.

Balthasart Cylindrical projection: An orthographic projection onto a cylinder secant at the 50
degrees parallels. It is cylindrical equal area, but distortion of shape increases with distance
from the standard parallels. Scale is true along the standard parallels and constant between
two parallels equidistant from the equator. This projection is not equidistant.

Mercator: Mercator projection. Scale and angles correct only at the equator. Very distorted at
the poles.

Miller: Distances and angles are only correct on the equator. Shapes and areas are distorted,
especially at the poles - but less than with Mercator.

Albers Equal Area Conical: A conical projection which is useful for maps which are wider
than they are high, such as the continental United States.
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Stereographic, Polar Stereographic (North and South): A projection which has minimal
distortion at the center of the map. Most useful for maps that are zoomed to show whole
countries.

Transverse Mercator: A projection which has minimal distortion at the center of the map.
Most useful for maps that are zoomed to show whole countries.

Map Legend
Default unit tites for Map Legends
Km |km
Miles | miles
Metres | metres

Yards | yards

Feet | feet

Sets the default unit titles for map legends.

Locations

Locations for the installed components,
Changing these settings will require a server restart,

Combination | C:\ProgramDataiCombination’ | Browse...

Relief Data | C:\ProgramData‘\Relief), |Eruwse...

Street Data | C:'\ProgramDataVizrtiviz World\\MapData\StreetDat| | Browse. ..
Disputed
Reqgions

CDEM Data |C:'n,Prn:ngramData'n,‘l.-'izrt'n,1-'iz 'n.f'.n'c'rld'n,'n,r'«"lapData'n,Curin:nusDE| Browse. ..

| C:\Program Files\Vizrtiviz 'l.f'.n'u:urld'n,MapData'n,Disputede| Browse. ..

Matural

Earth Installed Imagery...

The Locations parameters define the path to folders containing relevant data for the specified
parameters.
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- i

| Matural Earth Imagery ==
Datasets
Microsoft Virtual Earth Ef:fr:';‘::fgg View Dependent

DigitalGlobe ..ine (Platinum) ool dtion is View Dependent

DigitzlGlobe ... (US Domestic) EE:LD;;:QDEE View Dependent

Overlays

M 15m-BASE-N...im-Japan-CMR 17588 x 31841 11 Meters/Pixel | 1 color correction

% 45em-Minam...a-lapan-CMR 20748 x 12250 0.40 Meters/Pixels

?‘ 45cm-5endai-Japan-CMR 27646 x 36536 0.39 Meters/Pixels

g lq | Shiow all

Patk:  C:Wit SoftwareWVie Curious Maps'\JAPAN-CMB2\15m-BASE -Morthern-Japan-CMRMT | Edit

E

The Natural Earth option can be used to add, remove and color correct global and/or local CMR
(Curious Multi Resolution) imagery. Global imagery is what is typically used as base maps, whereas
local imagery are more detailed imagery of local places (e.g. coastal areas and cities).

See Also

Open Street Map Downloader

User DEMs

Imparted DEM (Digital Elevation Model) Data

Imported Relief Data is stored in a directory as mipmap
files and can be shared amongst users if placed in a
shared directory.

C:\Program Files\Curious Software\Curious World Map:

.A.
»

Max undo disk usage (ME) 100

The User DEMs (Digital Elevation Model) define the path to a folder containing elevation data.
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Attribution

Set the position of the on-screen attribution by dragging
it to the desired position:

[ |

CQutput Attribution in this font: "

Defines where the attribution should be placed on the screen.

Attribution image (gray rectangle): Sets the location of the attribution image on screen.
Output Attribution Font: Sets the font used for the on screen credit.

To position the attribution image

Drag the gray rectangle that represents the attribution image area to the desired position.

Bing
Bing Cache
IJse this option to change the location of the Bing cache.

F:\MapData'PlanetObserver 15 Browse. ..

Empty Cache

Bing Connection

| Test Connection |

Bing Maps Platform (previously known as Virtual Earth) is a set of images (satellite and others)
stored on Microsoft’s Bing Maps Platform servers. The images can be used by Viz World Classic,
but requires a credit mark (Attribution image) to be displayed on screen.

Bing Cache: Defines a cache folder for the images retrieved from the Bing Maps Platform
server.

Empty Cache: Deletes all files from the cache folder.
Bing Connection: Allows you to test that the Bing Maps Platform server is online.

& Note: Microsoft Bing requires an internet connection and will not work without a
license.
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Digital Globe
Digital Globe Setting

|Use this option to change the location of the Digital
Globe cache.

Wi \MapData\MaturalEarth\DigitalGlobe_Cache Browse...

Empty Cache Expiration Time 30

IUse this option to change Digital Globe Url.
https: /fservices. digitalglobe . comfearthservice fiwmtsaccess [ﬂ

Test Digital Globe Connection

Ise this option to change First Look Url,
http:/feevewe. digitalglobe . com/firstookrss fevents.rss [ﬂ

| Test First Look Connection J

Digital Globe cache: Sets the location of the digital globe cache. For reference, see the

Bing section.
Digital Globe URL: Set the URL of Digital Globe, allowing you to configure new parameters if

Digital Globe’s API changes.
First Look URL: Sets the URL of First Look (deprecated)

& Note: Digital Globe requires an internet connection and a license. If used without a
license a watermark will appear.
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Google Maps Settings

Use this option to change the location of the Google Empty Cache
Maps cache.

C:'\ProgramDataVizrt\viz World\\MapData\MaturalEarth\Google_Cache | Browse. ..

Test Google Maps Connection

Empty Cache: Clears the cache
Cache location: Sets the location of the Google Maps cache. For reference, see

the Bing section.
Test Google Maps Connection: Tests the connection

& Note: Google Maps requires an internet connection and a license.

Proxy Settings
The Viz World Server should be allowed to access the following servers:

http://www.digitalglobe.com
https://services.digitalglobe.com
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Display

Alternate Label Display

|Ise this option to choose the order in which alternative
place and region names are presented,

M-Language vl lL.Iser v| |5tandard v] |Abbreuiaﬁun v] [.ﬁ.Jternate -

Street Data
[¥] Draw streets with square ends

[¥]square ends for pre-connected data, round otherwise

Street Addres Format: -

Auto Feature Preview
Allow features from types

[V Country [¥]5ub Region [V Motorway [¥] Other Road
[V] Capital [V Town 100K W] Primary Road

[¥] Town = 1M [¥] Town 10K [¥] Main Road

[¥] Region [¥] Town 1K [ secondary Road

Mare Label Setting

[] Automatically scale map labels - based on the default template size
["] prefer Region Capital Label

[¥] Fit Map By Width

Alternate Label Display: Sets a custom language and defines the labels’ source priority,
effecting the list of label options displayed to the user. For creating multi-language files and
using them see the Map Name Editor and the Using the Map Name Editor sections.

Street Data: Defines the visual properties of street edges when drawn on the maps.

Auto Feature Preview: Defines what features will be previewed in Viz World’s Map Editor
(WME) when pressing the auto features button.

More Label Setting:

- Automatically scale map labels: When this option is checked, changing the size of a
project or TPL label styles will also scale the labels proportionally. Note: This only
applies to label styles created in Viz World Classic and used with the Map Editor
Classic.

Prefer Region Capital Label: When turned ON the auto-features will force the type of
feature to "Region Capital" instead of based on the feature size (e.g. Town 1K, Town
1M) which is the default

Fit Map by Width.

See Also

Map Name Editor
Using the Map Name Editor
Maps Configuration
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Street Admin

- Australia

- Belgium
-Denmark
-Finland
-France
-Germany
-Great Britain
-Ttaly
-Luxembourg
-Metherlands
-Marway
-Portugal
-Russia

- Spain
-Sweden
-USADY.02.01

B EEE

The Street Admin section is used to display information about the loaded roads data in the system
and road data licensing information.

Re-Scan: When pressed, the configuration tool will check the loaded street data and refresh the
display.

Imported Data

Allows you to add shape files (shapes, lines, names and so on) which later can be imported to Viz
Artist through the Map Editor ( WME) and added to your map.

Plugins

Ave Mame Version

Plugin

Plugin ;: Yahoo PlaceFinder

Config :

[¥] Active
A list of plugins that are used for searching the web (not the Viz World database).
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Place Finder
Praoject and Style

Froject Mame:

Style:

tap Size

b ap width: : tap Height: :
Framing

Frame Map Bu: Search Result -

Degault Map Size [Deq):

Reqgionz and Labelz
Add Regions: Disabled -
Full Deszcription Labels

Add Search Label

Viz World Server allows receiving maps of locations/features, same as the Place Finder plugin. This
can be used by Escenic or any other web application, or for demonstrations of Viz World. For more
information, see the Place Finder section.

7.1.7 Standalone Clients
A standalone client is an application running WME on machines without a Viz installation.

Export Folder: Defines the save path for standalone client applications.
Configuration for standalone dients

Export Folder | C:\Program Files\Curious Software\Curious W

Export Formats: Image formats are presented to users when saving images. Add a format for
each combination of file format and compression options you wish to use. The Options
button allows you to set color (black and white, grayscale, 256 colors etc.), and filter
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options.

Image formats are presented to users when saving images. Add a format for
each combination of file format and compression options you wish to use.

Export Formats | IPEG - Best (*.jpa)
JPEG - High (=.jpag)
JPEG - Medium (*.jpg)
BMP (*.bmp)

SGI Image (=.s0i)
Photoshop (*.psd)
Compuserve GIF (*.gif)
PICT (*.pct)

PNG (*.png)

TGA (= tga)

QuickTime Image {*.gtif)
Compressed Tiff (*.4f)

Geotiff (*.tf)
Mame:
| ]
[ ] Georeferenced
[ 130 Terrain | [v]
Width % Height =
[ Add ] [ Remove ]
7.1.8 Symbols

Viz World User Guide - 17.0

Symbols are created and exported from Viz World Classic, and can be imported using the server

configuration tool such that client users can add them to their maps.
See Also
Symbols Tab
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7.1.9 Timeouts

User Timeouts
IUsers are automatically logged off after
10 = minutes inactivity (Plugins)

10 minutes inactivity (interactive navigator)

4

Perindic Restart

The server will only automatically restart when there
are no users connected.

Restart server periodically
(%) After 12 2. hours

(T AtTime 0L:00 || time

This section is used to set server timeout values.

Viz World User Guide - 17.0

User Timeouts: Sets the timeout values for clients logged onto the server:
Minutes Inactivity (Plugins): Sets the timeout for client connections when the WME is
opened through the CMWClient plugin. If no map requests are sent to the server
during the period of time (in minutes) specified in this parameter, the server will

disconnect the client.

Minutes Inactivity (Interactive Navigator): Sets the timeout for client connections when
an interactive Navigator scene is used. If no map requests are sent to the server
during the period of time (in minutes) specified in this parameter, the server will

disconnect the client.

Periodic Restart: Enables automatic restarts of the server. It is mainly targeted at 24/7
stations, where Viz Engines are up and constantly requesting maps. The Automatic restart
enables the server to restart at the specified time or after a defined period of time,
disconnecting all clients and clearing used memory. This is important when the server is

used heavily and a lot of maps are generated.

Restart server periodically: Sets the server to restart periodically based on the After or

At Time parameters.

After: Sets the amount of time (hours) for how long the servers should be running

before the server should be automatically restarted.

At Time: Sets the time for when the server should be restarted.
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7.1.10 Proxy Server
Proxy Account
Mame:

Password:

This section is used to define the proxy server connection settings. Viz World Server will connect
to the internet to fetch data from Bing Maps Platform or Imagery on Demand servers. If the system
uses a Proxy Server that requires authentication, this page is used to provide the login details for
the Proxy Server.

Name: Sets the user name.
Password: Sets the user password.

See Also
Bing
Digital Globe
Google Maps

7.1.11 Server Logging
Server Debugging

|:| Output messages in server log

This section defines whether or not the server will log system messages to a log file.

7.2 Viz Engine/Artist Configuration

This section contains information on how to configure the Viz Artist render engine.

Copyright © 2019 Vizrt Page 41



Viz World User Guide - 17.0

Maps Configuration

localhost

DrefaultProject.tpl

DrefaultProg

Available design_20

design_2012_VIZ_FLADT.tpl

Map Size Width 1024 S[7 Height 1024 5[

Cache Directory c:ftemp/mapscachel

Memory (Images) 32 Pr On disk (Days)

iz World Version 12.0 And Above

2nd Cache Directory ciftemp/mapscache2

Priority 4 ||:|_ Netwaork Manitor Inactive
Attributions w

Attribution Font YWerdana

Bold

5 Italic lﬁ

On Top off On Right Off
[off” [off

Map Server: Enables or disables Viz World Server (WoS) connection for Viz World Client

(WoQ).
Server: Sets the Viz World Server host.

& Note: If a Server Allocator is used, it should point to this location.

Project: Sets the default map project that will be opened with the client application.
Available: Lists all available Viz World Server projects.

Map size: Sets the default map size that will be used with the client application.

Cache: Enables caching of maps for faster preview and fetching of maps. Especially useful
for journalists and operators using Newsroom Component and Viz Trio respectively.
Cache Directory: Sets the cache directory for cached maps which can be a local drive,
mapped drive or a Universal Naming Convention (UNC) path.

& IMPORTANT! Make sure the Cache Directory folder is configured with read and write
access rights.

Memory (Images): Sets the number of images to keep in memory.

On disk (Days): Sets the number of days to save images on disk.

2nd Cache Directory: Enables a second cache (see Cache above). The main purpose of the
second cache is to enable redundancy in those cases where a main cache directory is on a
different computer and for some reason fails. Another use case is to use it as a local cache
to save loading time (e.qg. if you load all borders for the entire world you would have 100MB+

Copyright © 2019 Vizrt Page 42



Viz World User Guide - 17.0

of cached files). In order to shorten load time you can copy large static files to the correct

local cache folder. In the 3D Map Setting plugin you will also find a Sync Local Cache Folder

button which will copy all the needed files to your local cache. Note that the second cache
directory settings can only be used by Viz World version 12.0 and later.

Priority: Sets the machine’s connection priority to the Viz World Server (WoS). Setting a

number, where 1 is the lowest and 100 is the highest you may override connection priorities

set by other machines. The configuration interface will allow you to prioritize client
connections from Viz Artist and On Air Viz Engine’s used for preview and program output.

Viz Engines must be in On Air mode for them to be prioritized. For Viz World’s Map Editor

you can set it from the Context Menu. To enable this behavior on the server side you need to

enable WoS to prioritize its connections/logins. If the configuration option is not visible,
please read how To add the VizWorld.ini file and set the priority.

Network Monitor: Enables you to monitor relevant network connections (server and cache

folders). If you do not monitor the network and you try to connect over a “disconnected

network”, connecting to a server or a UNC path, it will take time before the system reports
back (e.g. 30 seconds or more). Enabling network monitoring will avoid such connection
issues. Note that the network monitor will only monitor a cache folder that use a UNC path

(not mounted/mapped drives). If the configuration option is not visible, please read how To

add the VizWorld.ini file.

Languages: Sets the current language to be used on labels fetched from Viz World Server.

For more information, see the Display section.

Attributions: Adds an attribution to the map. Alternatives are; Static and Dynamic.
Dynamic: Displays the attribution when a licensed imagery is in view and disappears
when the image is out of view.

Static: Displays the attribution as long as there is a licensed imagery in the scene.

Attribution Font: Sets the font for the attribution.

Bold: Sets the attribution font to bold.

Italic: Sets the attribution font to italic.

On Top: Places the attribution image to the top in the screen. Default is bottom.

On Right: Places the attribution image to the right in the screen. Default is left.

7.2.2 To add the VizWorld.ini file

1. Create a and save a VizWorld.ini file to the following location:
C:\ProgramData\vizrt\viz3\Maps
2. Open the file and enter the following:

Monitor=1
Priority=1
Language=[my Language ID]

3. Save the file and start e.g. Viz Config to see the configurable parameters

Monitor enables network monitoring. See the Network Monitor setting, listed above.
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Priority sets Viz’ connection priority to the Viz World Server. See the Priority setting listed above,
and the Server Launcher Configuration section on how to enable prioritized connections on the
server side.

my Language ID refers to the order of languages in your list of languages (e.g. English = 0, Arabic
=1, Hebrew = 2 and so on). See the Languages setting, listed above.

7.3 Cache Configuration

When working with Viz World in a server/client environment, a cache is used to reduce the load
time of scenes in Viz. The cache is a shared network storage folder, common to all Viz Engines in
the system. The cache is managed by the Viz Engine machines.

& Note: In complex environments, Viz Engine machines can be grouped so a different cache
is defined for each group.

This section contains information on the following topics:

Map data flow

Cache Location
Defining the Cache
Cache Folder Structure
Caching - Viz Trio
Caching - Viz Pilot

7.3.1 Map data flow

The maps data stored in the cache is produced by the Viz Engine machines, running World Map
Editor applications. When WoC is launched, it connects to the server and enables the user to select
a map and add information to the map. When the user accepts the selected map (by pressing the
OK button in the maps editor (WME)), the map information will be sent to the scene (and to the
relevant WoC plugins used in the scene) from the server. WoC plugins will load the received data
and then store it in the cache. Now, when a scene is initialized, the WoC plugins will look for the
data in the cache and load it, without connecting to the server.

Since the most time-consuming task in this process is generating the maps, using the cache
reduces that time to a minimum and the maps are generated only once.

& Note: Before setting a cache folder in a server/client environment, a shared network drive,
mapped on all Viz Engine client machines should be created. The cache folder is defined
on the shared drive, so all machines will have access to the cache.

7.3.2 Cache Location

The following are some simple guidelines that will ensure caching is optimized when using one or
several Viz Engines.

One: Set the cache location local to that renderer.
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- Two or more: Set the cache location to the map server (or other shared network drive) so
that one renderer is not favored over others.

7.3.3 Defining the Cache

The client cache is defined using Viz Engine’s configuration tool (Viz Config). When configuring
the cache environment make sure that the following parameters are identical on all Viz machines:

- Cache Directory
- On Disk (Days)

& Tip: Control clients should have their cache location(s) set to the same location as
defined by the Viz Engine(s).

To configure the cache directory

Cache Directory c:/temp/mapscachel

32 rl-:-r On disk (Days)

1. Start Viz Config or open the configuration interface by clicking the Config button on the
main menu in Viz Artist

2. Select the Maps section

3. Set the Cache Directory to the defined shared network drive and the folder used as the
cache’s main folder

& Note: The Cache Directory has to be identical on all Viz Engines that share the cache.
UNC paths are also supported.

4. Set the Memory (Images) to the required value (default is 32). This parameter defines the
maximum number of map images stored in Viz memory when initializing a playlist

& IMPORTANT! Set the number of images to zero (or a low value) on control machines
used in the system. The control machines are inferior to Viz Engine machines and it
makes no sense to load a large number of images when it is only used for preview.

5. Set the On Disk (days) parameter to the maximum number of days that the images will be
stored in the cache. When Viz is launched, it will clean the cached map images that are older
than the value defined in the On Disk (days) parameter

6. Click Save

To configure the 2nd cache directory

2nd Cache Directory c:/temp/mapscache2

Priority Metwork Monitor m

1. Start Viz Config or open the configuration interface by clicking the Config button on the
main menu in Viz Artist

Select the Maps section

Set the 2nd Cache Directory to your local computer or a defined shared network drive and
the folder used as the cache’s main folder

w N
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4. Optional: Enable network monitoring
5. Click Save

See Also

- Viz Engine/Artist Configuration

7.3.4 Cache Folder Structure

When using cache in a client/server configuration, WoC plugins will manage the cache and sort
generated data in several folders under the cache folder. The cache folder hierarchy is created
automatically. Only the cache root directory is configured in Viz. The defined cache folder for all
clients is the root cache folder. Under the root cache folder, a version sub folder is created using
the WoC plugins version. Under each version folder, several sub folders are created, according to
the requested data:

3DLine-Cache: Stores lines from the WME as OpenGL vertices.
3DBorder-Plugin-Cache: Stores selected borders based on the Region-Cache data.
3DRegion-Plugin-Cache: Stores selected regions based on the Region-Cache data.

- AtlasCacheFolder: Stores Downloaded images from Microsoft to enable a smooth animation
and faster response time during navigation. Images are stored under sub-folders according
to the texture compression used.

BorderManagerFullWorld-Cache: Stores unselected borders based on the Region-Cache data.

- CWMClient-Cache: Stores map images and label information that is reused by Viz when
loading the scene.

Region-Cache: Stores region vector data.

- Street-Cache: Stores street vector data.
- StreetManager-Cache: Stores unselected streets based on the Street-Cache data.

& Note: The 3DBorder, 3Dregion and BorderManagerFullWorld cache is based on
Region-Cache data after a projection is set, and converted to an OpenGL format.

& Example: The country Norway will only have one cache file under Region-Cache
(since there is only one Norway), but could have many under other folders with
different projections.

General Caching Rules

The CWMClient-Cache folder is cleaned when Viz is launched (any of the Viz Engines using the
cache), according to the On Disk parameter value.

The data in the cache folders (except for the CWMClient cache) are not deleted when cleaning the
cache since it does not change and it can be reused all the time.

See Also

- To configure the cache directory

Copyright © 2019 Vizrt Page 46



Viz World User Guide - 17.0

7.3.5 Caching - Viz Trio

This section describes Viz Trio specific commands/actions that influence how map data is cached
when Loading pages, Initializing all pages and performing a Direct Take.

& IMPORTANT! Set the same cache directory for the local Viz, and program and preview
channels.

Loading pages

Opening a scene for preview generates all cache files needed for the scene in the file cache. Any
change to the page through Viz Trio (CWM location, hop locations, labels, selected regions and so
on), immediately generates all required cache files. When pressing Take, Viz Engine will load to
memory all needed map cacheable elements through the file cache that the preview machine just
generated without the need to connect to the map server.

& Note: Applies only if both of them have same cache folder.

Initializing all pages

The Initialize All button/command will load all scenes to memory (program & preview renderers).
All necessary map data will be loaded from the cache files.

& Note: It is assumed that each page has been loaded in preview once before, and that cache
files have been created.

Direct Take

The Direct Take button/command will immediately load the scene into Viz Engine. All necessary
map data will be loaded from the cache files that the preview has generated once.

& Note: It is assumed that each page has been loaded in preview once before, and that cache
files have been created.

See Also

- To configure the cache directory

7.3.6 Caching - Viz Pilot

Caching of map data can be achieved by running Viz Pilot’s Thumbnail Generator on the same
machine as your Viz Engine.

See the Viz Pilot User Guide on how to setup and configure the Thumbnail Generator.

When running Viz Pilot in a non-preview configuration, any change to any map element that
requires caching will not create cache files. This will result in longer loading time of the Viz Engine
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because data maps, labels and polygon data has to be requested from the map server. It is
important to request at least a single image preview, such that cache files will be created.

& IMPORTANT! If you are running a local Viz, set the same cache directory for the local Viz as
for the program and preview channels.

See Also

To configure the cache directory
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8 Server Operation

This section describes how to start Viz World Server (WoS) and how to use the Server Launcher to
start, stop and configure the WoS and Server Allocator.

This section contains information on the following topics:

- Starting Viz World Server
- Server Launcher
Using Server Launcher
- Server Launcher Configuration
- Server Allocator Configuration

8.1 Starting Viz World Server

8.1.1 To start the Server

1. Double-click the desktop shortcut, or
2. Select the program from the Start menu.
- All Programs > Vizrt> Viz World Server

A console window appears that loads the database. When done, the server is ready to receive
requests from clients.

8.2 Server Launcher

_I:I-

Viz World Server Launcher

Options ... Start

Viz World’s Server Launcher is a tool used to start, stop and configure the Viz World Server and
Server Allocator. In addition, it will also start a process that generates thumbnails of map
templates used by the Viz World Client’s Map Designer tool.

8.3 Using Server Launcher

The Server Launcher is an application installed as part of the Viz World Server, and can be found
on the programs menu. The Server Launcher is run as a service by default.
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When the Server Launcher is configured, the Server Allocator distributes client requests between
the registered servers and server machines, balancing server loads and the number of client
requests. When configured in a complex environment, multiple map servers with multiple Server
Allocators can be used to allow full redundancy and optimal resource distribution.

Starting a single instance of the maps server can be done from the program menu or by using the
desktop icon.

Starting the Server Allocator, in order to setup a redundant system and/or configure more than
one instance of the map server on one server, is done using the Server Launcher.

When the Server Launcher is running it will typically be floating on top of the desktop; however, it
can be minimized to the tray.

8.3.1 Desktop Icon
]

The status of the Server Launcher is indicated by the color of the icon:

Normal icon + green led = Licensed, running

Normal icon + grey led = Licensed, not running

Greyed icon + green led = Not Licensed, running (this only applied to Service Allocator, since
it is not licensed)

Greyed icon + grey led = Not Licensed, not running

8.3.2 Tray lcon
The tray icon allows you to minimize the application to the tray and restore it.

Minimize To Tray
Skop Server

Oipkions

Exit Launcher

Exit & shutdown Server

Restore / Minimize To Tray: Restores or minimizes the Server Launcher from or to tray.
Start / Stop Server: Starts and Stops the Server Allocators and the Viz World Server without
exiting the Server Launcher application.

Options: Opens the Options window for configuring the number of Viz World servers and
Server Allocators. See Server Launcher Configuration for more information.

Exit Launcher: Closes the Server Launcher application. Server Allocator and Viz World server
will still be running.

Exit & Shutdown (Not Recommended): Closes the Server Launcher application. Stops all
Server Allocator services and the Viz World server.

Copyright © 2019 Vizrt Page 50



Viz World User Guide - 17.0

8.4 Server Launcher Configuration

Options El

Preferences

Local Server Count |2 VI " Service

v Enable Priority login

v Run Server Allocator

Launch Cptions

[¥ | start on systen skartup

' Console application

Moke ; ¥iz World Server will stop if console is

rControlled WS

Machine |bgonrange2 j
Count m

Priotity Iﬁ _‘
Instancesl-"-"— ek

Machine Count | Priority | Instances |
211 Jal

Ok I Cancel |

Viz World Server is configured using the Server Launcher.

Click the Server Launcher’s Options button in order to configure the map server.

Preferences: Allows the user to set the local server count and enable the Server Allocator.

Local Server Count: Defines the number of server instances that will run on the
machine simultaneously. Default value is 1. When setting the number of instances for
each machine, machine hardware should be considered. Every server instance requires
physical memory (RAM) and makes intense use of the CPU. Do not abuse this
parameter, since client and server performance will be affected.

Enable Priority Login: Enables Viz World Server to prioritize its inbound client
connections. Viz’ configuration interface will allow you to prioritize client connections
from Viz Artist and On Air Viz Engine’s used for preview and program output. Viz
Engines must be in On Air mode for them to be prioritized. For the Map Editor you can
set it from the Context Menu. For more information on how to set priorities see

the Maps Configuration section.

Run Server Allocator: When disabled (not selected), the Server Allocator will not run on
the machine. When enabled (selected), the Server Allocator will run and use the
parameters defined in the Server Launcher’s Options window. Default mode is
disabled. Server Allocator does not require any license and can be run on any
machine.

© Important!
If the Server Allocator is enabled, even for just one machine, the machine must

be defined in the Controlled WoS list.

Launch Options: Allows the user to run Viz World Server and the Server Launcher as a
service, or in console mode. If run as a service, the system can automatically start all server
instances when the machine starts without the need to login. If run in console mode, all
instances must be manually started.
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Controlled WoS: When enabled (see Run Server Allocator), the Controlled WoS settings allows
the user to configure the controlled WoS instances.
Machine: Sets the name of a machine running Viz World Server.
Count: Sets the number of instances running on the machine. Default is 1.
Priority: Sets the machine’s priority. If more than one machine is defined, the priority
must be set for each machine.
Instances: Sets the number of instances that are controlled by the machine. If the

machine has more than one instance running, it is possible to open the Instance
Control (click Set) To set the controlled instances.

A Note:
When the Server Allocator allocates a server to a client, it will pass this name
to the client, hence, its hostname/IP address must be accessible to all clients.

8.4.1 Setting Priorities

Normally all servers will use the same priority (1). In more complex scenarios a lower priority can
be used, for example when two servers are running two instances each and an allocator.

One server is typically dedicated to an On Air engine and another to a Viz Artist (designer) client
such that a designer client will not steal a token from an On Air engine.

Example setup:

Map server A is for the On Air engine and it controls two instances on map server A with
priority 1, and two instances on map server B with priority 2.

Map server B is for the Viz Artist designer and it controls two instances on map server B with
priority 1, and two instances on map server A with priority 2.

The Server Allocator will not redirect any clients with map server A as default to map server
B if it can give them an instance on map server A because map server B has a lower priority.
So, only if the instances on A are out of license tokens, or not responding, the Server
Allocator will direct clients to map server B. And the same for B.

Another example is in a scenario where there are two allocators (one in Location 1 and another in
Location 2), all clients from Location 1 should be connected to the server in Location 1, and all
clients from Location 2 should be connected to the server in Location 2, and only if anything goes
wrong should clients be allowed to connect from Location 1 to Location 2.

8.4.2 Configuring the Server

8.4.3 To add or remove instances

Click the + or - buttons in the Options window to add or remove instances.
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8.4.4 To set the controlled instances
=]

Instance | Controlled I
1 Conkralled
2 Mok Controlled

Cancel |

1. Click the Set button in the Server Launcher’s Options window.
2. Double-click the instance to set the control mode to Controlled or Not Controlled.

3. Click OK.

& Note:
The number of controlled instances is displayed in the Instances field and column

seen in the Options window,

8.5 Server Allocator Configuration

Optimal usage of system resources can be obtained by using multiple map servers, running
multiple map servers on each machine, with a Server Launcher launched on each of the machines.

The system can be configured with:

- one allocator for multiple map servers,
- one allocator on one machine with multiple servers, or
multiple allocators with multiple server machines.

8.5.1 Single Server Allocator Configuration

The simple environment setup is when running one map server with multiple map server instances
and a Server Operation. In this configuration, the Server Allocator will accept client requests and
divert them to the server instances on the same machine. Client connections will be equally
divided between the map server instances, allowing better response time and load balancing of
server processes.

8.5.2 Multiple Server Allocator Configuration: Classic Redundancy
Having multiple servers, where in each there is a Server Allocator running that controls all WoS
instances of all machines.

This configuration guarantees most redundancy as each Server Allocator is updated with the
current status of all WoS servers, and in case of a failure in one of the machines, other Server
Allocators can provide redirection to any available WoS.
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The maximum number of server instances that can be run per machine is 4. Each server instance

should have 4GB of memory and 2 CPUs. So on a machine with 4 dual CPUs and 16 GB of memory
you can run the maximum of 4 server instances.

Server A Sarver

Server Server B
Allocator

Allocator

Wiz Whodd Wiz Wold Wiz Wold Wiz Wold Wiz World
Sarver SErver Server

Wiz Wold Wiz Wold Wiz Wold
Sarver Sarver SEiver SEiver SEiver

The above diagram describes a system with two machines running a Server Allocator and four map
server instances on each machine. If the client is configured with both machine names, full
redundancy within the system will be accomplished.

& Note: Any configuration combination between the Server Allocators and the map server
instances is valid.

See Also

Server System Requirements
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9 World Map Editor

The World Map Editor (WME) is a component of the Viz World Client. WME allows you to browse
and select map features, similar to those created using Map Editor Classic. In comparison with Map
Editor Classic, Map Editor offers almost the same features, which allow you to create stunning
maps in no time.

This chapter contains information on the following topics:

- Getting Started
- Tools
- World Map Editor Shortcuts

9.1 Getting Started With Map Editor

@ Map Editor (WME)

Open Project
Projects Favontes

Projects

Once you have the Viz World Client installed you can start the Map Editor and connect to the Viz
World Server. Once connected you will be able to open existing design projects.

9.1.1 To start the Map Editor

Normally the Map Editor will be launched from Viz Trio, Viz Artist or Viz Pilot.
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9.1.2 To connect to Viz World Server

& Note: When the Map Editor is launched from a Vizrt application (e.g. Trio, Artist, Pilot), it
will automatically connect to the server that has been configured within that application,
rather than the server configured within the Map Editor.

1. Start the Map Editor

=
Click the Settings button
Set the Viz World Server hostname. If not specified, the Map Editor will connect to localhost.
Click Save

bl

9.2 Tools

This section contains information on the following topics:

Map Editor Toolbar
- Settings
- Search
Layers
Extra Data Manager
Details
- Shapes Tool
- Streets Tool
- Show or Hide Map Features
Quick Map
Locator and Preview
Preset Editor
Multihop Editor

9.2.1 Map Editor Toolbar

The Map Editor has the following toolbars:

Horizontal Toolbar

- Vertical Toolbar
Quick Map Toolbar
Locator and Preview Tabs

Horizontal Toolbar

Matural Earth l }" j!.

The horizontal toolbar contains the following options:
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Save Favorites: Save current project as a favorite project. Unlike projects which only
contain the base map styling, a Favorite is a project which also has data saved as part of it,
such as selected countries, loaded streets, and labels.

& Note: User favorites will not be synchronized across servers when working with
server allocator. When working with multiple servers, synchronizing user favorites
can be done as an automated process of replicating the relevant folders. User
favorites are stored by default under C:\Program Files\Vizrt\Viz
World\Users\Default\Favorites.

Open Favorite: Open a favorite project.

Open Project: Open existing map template files.

o) Undo: Undo last change

Redo: Redo last change

g

- Copy Map to Clipboard:
Click the icon to copy the current map view, and its details, to a clipboard that can be
used later on when reopening World Map Editor.
Select a previously copied map from the dropdown. The clipboard is a local list, for
the currently active directory.
Delete an item from the clipboard list by right clicking an item and selecting Delete
from the context menu.

Search: Search the map.

Select stylesheet: Select one of the template’s available stylesheets.

If the stylesheet uses either Digital Globe or Microsoft Bing, an additional dropdown will

allow you to select the profile of imagery to use from the provider. The different Profiles
provide a different imagery set for the same location.

DigitalGlob

Consumer ¥ 1 O ,.lf|r1dru:a1 E{:|U|::||-r

= _—
Consumer ﬁ X,

True Currency
Cloud Cover
+ Vivid (Mot Licensed)

& Note:+Vivid provides a set of seamless tiles of imagery for every level, however some
images may not be the most recent imagery. The +Vivid option on Digital Globe is a
paid subscription, contact your local Vizrt Sales representative if you require a
license.

ﬂ Notifications: Displays notifications of errors.

e
Settings: Change the Settings (Viz World Server, Language, Map Legend, Safe Guide)
ﬂ Information: Displays version information about the Viz World Client and Server.
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Vertical Toolbar

The vertical toolbar contains the following options:
- -
sl Layers: Enables you to search for and filter features based on the current map Layers in
view.

Details: Shows the Details for all selected features. Right-clicking the button will open a
context menu that allows you to fit to, center to or clear all details.

ﬂ Pan: Enables the user to click and drag on the map to move the map in the direction of
the drag.

E Zoom: Zooms the map according to the area selected. To select an area, click and drag
to draw a rectangle.

E Shapes tool: Opens the Shapes Tool. Right-clicking the button will open a context menu
that allows you to select the shape.

E Streets tool: Opens the Streets Tool.

L] Inverse Colors: Toggle the color of the map legend and map features (countries, cities,
etc.) See Settings for how to enable/disable the map legend.

Eﬂ Show/Hide Features on Map: Click the button to show or hide the selected map
features. Click the arrow to select which map features to show. See Show or Hide Map
Features.

Quick Map Toolbar

Q ® World P Australia P New South Wales

Use this to access the Quick Map features.
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Locator and Preview Tabs

Use this to access the Locator and Preview features.

9.2.2 Settings

Settings

Server worldserver
Language English
Map Legend ITI

Safe Guide

Server: Set the Viz World Server hostname. If not specified, the Map Editor will connect to
localhost.

Language: Select from the available map languages. See Map Name Editor for information on
how to configure the languages.

Map Legend: Enable or disable the map legend.

Safe Guide: Enable or disable a safety area around the map (e.g. for text safety)

9.2.3 Search

Toronto Canada|
» Filter

Ep Toronto, Ontano, Canada

] Toronto, Canada

» Web Results : 6

The search option allows you to search for, and add notable locations to the map. The map can
then be fitted, or centered around these locations.

From the results list, each item has the options:
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. {hf’ﬂ : Add/remove the selected location to/from the map
& Fit the map to the selected location

. : Center current map view to the selected location
All locations that have been added to the map can also be edited from the Details view.

9.2.4 Layers

Places

Places Streets Shapefile KML First Look

Filter

Sort by: Type 4

# QOradea, Bihor, Romania
i M ojorid, Biher, Rernania
dnmartin, Bihor, Rormania

Displaying 3 features

Enables you to search for and filter features based on the current map layer in view. You can also
sort based on Country, Name, and Type.

Streets
Toolks

Places Streets Shapefile KML First Look

Select Streets to Load  Load Visible Streets

Only Visible on map

L |
* fArad, Ro

This tab allows users to load street data by clicking Select Streets to Load, and using the Extra
Data Manager, as well as add items to the map using the Extra Data Browser.

The roads in the visible map can be loaded into the list by clicking Load Visible Streets.
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Shapefile

Streets Shapefile KML First Look

Load Shapefiles

This tab is to allow users to load Extra data such as Shape files.

KML
Tools

Places 5 s Shapefile KML First Look

Open Upload

The KML Manager lets you load Keyhole Markup Language (KML) files which can then be added to
the map. The KML file can be uploaded from the Viz World Server or opened from a local file.

Load: Load a file from the Viz World Server. Clicking the Load button, opens the KML
Browser and lists all the available KML files. It works the same way as the Extra Data
Browser.

Open: Open a file from the file system, but do not copy it to the Viz World Server
Upload File: Open a file from the file system and copy to the Viz World Server

& Note: If the KML file includes a camera position, then the map will zoom to that
position, otherwise the map will focus on all of the data found in the file.

KML files can also be manually imported into the server, and must be placed in the following
folders:

32 bit:
C:\ProgramData\Curious Software\Curious World Maps\KML
C:\ProgrambData\Curious Software\Curious World Maps\Users\Default\KML
64 bit:
C:\Programbata\vizrt\Viz World\KML
C:\ProgramData\vizrt\Viz World\Users\Default\KML
Any files uploaded from the client will be stored in this same location.
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First Look
Streets Shapefile KML First Look

Only Visible on map

ng and Landslides in Brazil
5/01/2014
Australian Open Tennis
H Champicnships 2014

13/01/2014

@ Cyclone Ian, Tonga

= 12A0/2014

The events tab is a feed of events from Digital Globe’s FirstLook service.
FirstLook provides rapid imagery of major global events, such as:

Natural disasters: Earthquakes, fires, tornados, hurricanes
Man-made crisis: Terrorism, large accidents

Political instability: Riots, civil war

Human interest: World Cup, Olympics, F1, NFL

It requires a yearly license to use the imagery.

9.2.5 Extra Data Manager

The Extra Data Manager is available from the Layers Tool and allows users to manage extra data
that is stored on the Viz World Server.

& Note: In order to work with Extra Data, the Viz World Server must have data loaded.

& Note: Streets data requires additional license features and the installation of street data on
the server.

Using Extra Data

1. In the Layers tool, click on the Streets tab, to open the Extra Data Browser. (this will be
empty if no data has been selected).
Toolks

Streets KML First Look

Load Streets Load Visible Streets

Onby Visible on map

2. Click on Load Streets to open the Extra Data Manger.
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3. Navigate to the required data and use the Add, Fit and Centre buttons to select the data
and/or move the map.
Close the Extra Data Manager when finished.

4. Open the Extra Data Browser again to see all the loaded data and add features which are
related to the loaded data.

5. Data can be deselected either from within the Extra Data Manager or the Extra Data Browser,

using the ‘X’ button.

Extra Data Manager

In the Extra Data Manager, the view can be switched between Flat List view and Tree view, using
the buttons at the bottom of the window.

The Flat List view presents the data in a flat structure with a navigation bar at the top. To navigate
in the data, double-click an item in the list to open it, or use the drop-down menus. In this case,
the Filter only filters the content of the current directory.

The Tree view presents the data in a hierarchical structure. To navigate in the data, double-click an
item in the list. The Filter filters the whole tree and lets you navigate within the results using Enter
and Shift+Enter keys or the ‘A’ and ‘v’ buttons.
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Street Data
Filter
Only Visible on map

® Edradata P Complete data P | Europe P | Scandinavia-2012 %

- DK
FI
w fq

W NO NO

F SE

K

‘= Flat List

Street Data

Filter
Only Visible on map

¥ Complete data

Africa

America

Asia-Pacific

Demo

Eurocpe

k ==CzechRepublic-2009

¥ Austria-Switztrland-2007
N )
* Switzerland

* Benelux-2009

“=Tree ‘= Flat List

Extra Data Browser

The Extra Data Browser displays all the loaded data and can be used to add features which are
related to the loaded data.
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KML First Look

Load Streets Load Visible Streets

Filter

Only Visible on map

¥ Finnmark, No
¥ Hordaland, No
¥ Streets
Motorways
Primary Roads
Main Roads
Secondary Roads
Other Roads
Land Use A
Land Use B
Hospital Points
Rivers and Lakes

Islands

M-

9.2.6 Details

b i T (a] i n] r'|t|:|

& ONTARIO

MNews

Towns

Points of Interest
Transportation
Disasters

Traffic

Sort by: Type

= =5 5 5 5 5 =5 =

Displaying 2 details
M Remove All

== Bigycle
¥ Boat
M Bus

s Lar

582, nesttun bergen hordalan...
Agdestein, stord hordaland no

Apaltunnelen, lindas hordalan...

Arnanipatunnelen, bergen hor...
Arnavegen, bergen hordaland...
Arnavegen, indre arna bergen...
Beitlatunnelen, vaksdal hordal...

Bolstadtunnelen, voss hordala...

Displaying 196 features

N

# Helicopter

Viz World User Guide -

17.0

The Details view allows you to edit the name and appearance of details. Changes can be made to
multiple details by selecting them together. The details in the list can be reordered by dragging
them, or easily hidden from the map.

Custom styles and style families can be created in the Map Designer using the Style Editor. These
styles will then be available in the Editor.
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The icon used for each detail can be changed by selecting the detail in the list and browsing for a
new icon in the list of icons.

Details can be sorted alphabetically using the - buttons.

Displaying 2 details

W Ar Rayydn

ﬁ* rrm Sa'id

Show/hide each detail, without removing it from the list, by clicking the .. icon. When a
detail is hidden, it is not rendered in the scene.

Displaying 1 details
X Rermnove All

Clicking the Edit button next to each item in the Details list allows editing the following features:

All Caps: Caps on or off

Add to Database: New name alternatives (e.g. language specific) can be saved to the
database

Label Location: Adjust the location of the detail’s label.

Displaying 2 details
M Remove All

#7 TORONTO Fit o details

Center to details

M Mova Scotia h

Remove details

Clear all details

The context menu provides the following options:

Fit to details: Fits the map according to the selected details

Center to details: Centers the current view according to the selected details
Remove details: Removes all selected details

Clear all details: Removes all details regardless of selection

& Note: If the default style defined in the server is not available in the scene designs,
then the first design which is available in that scene will be used.
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9.2.7 Shapes Tool

=

=4 l.'-'UT@J KINGDOM

The Shape Tool lets users draw shapes on the map.

Context Menu

A right-click or a long left-click on the Shapes Tool icon will present a context menu with the
following options:

- Spline Shape: Draw segments of a smoothed, curved line. It can be closed or open. Double
click to finish drawing.
Linear Shape: Draw straight-line segments. It can be closed or open. Double click to finish
drawing.

- Closed Shape: The shape drawn is closed, i.e. the first and last points drawn will be joined.
Fill Shape: The shape will be filled. Forces the shape to be closed.

- Circle / Ellipse / Rectangle: Select a geometric shape. If none are selected, the tool will
default to drawing a spline or linear shape.

Copyright © 2019 Vizrt Page 67



Viz World User Guide - 17.0

Edit Mode

When the Shapes Tool icon is selected, clicking on an existing shape will present the Shapes
toolbar:

Lock/unlock the handles (only relevant to spline shapes): Allows the shape to be modified
more flexibly.

Remove the shape from the map.

Fit the map to shape.

- Center the map on shape.
- Convert shape to spline/linear (not relevant to geometric shapes).

Make shape closed/open (only relevant to lines).
Fill the shape with color.

- Change the shape style (for example an ellipse can be a Region or a Country). Note that this

may affect the appearance in Viz Artist scenes.

Shortcut keys

When a shape is in edit mode, the following shortcuts keys are available:

DELETE key deletes the shape.

- * (asterisk) key centers the map on the shape.

At any time, pressing the D key will activate the Shape Tool. When the D key is released, the
previously active tool will become active and the shape will be submitted to the Server.

To add a shape to the map

AWN—=

Click on the Shapes Tool icon to activate it.

Right-click on the Shapes Tool icon. A context menu will appear.

Select the kind of shape to draw, for example an ellipse.

Drag on the map to create a shape. When the mouse button is released, the shape is
submitted to the Viz World Server.
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To edit an existing shape

1. Click on the Shapes Tool icon to activate it.
2. Click on the shape you want to edit. A toolbar will appear next to the shape.
3. Use the Shape Tool to modify the shape.

9.2.8 Streets Tool

Y A b

> .. :j}_:‘}.__ & e ¢ et .__..
The Streets Tool can be used to add streets or segments of streets. It uses the data that has been
added by the Extra Data Manager.

When the Streets Tool is activated, a red dot will appear when the mouse is hovered over a street.
Clicking on the red dot brings up the Streets Tool menu bar.

2 aQ M
The Streets Tool menu bar contains:

- Add Segment: Allows the user to add segments of the street. Each click on the map adds a
segment. Double-click to finish the operation and submit the shape to the Server.
- Add Street: Add the selected street to the map.
Label Street: Add just the label without the line.
Fit the map to the street.
Center the map on the street.

Once a street is added to the map, the user can edit it using the Shapes Tool.
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The Show/Hide Map Features button toggles the features on and off. If they are on, a summary of
features is also displayed.

Auto  Regions | Towns | Streets | Other
"\ Regions
] Major Towns
& Minor Towns

L) Streets
s Places Of Interest

[-] Others

To configure which features will be displayed, click the arrow and select which map features to
show.

To modify a feature, you can also hover over the feature on the map to display the tool bar.
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AUCKLAND

& Note: You can also show or hide individual details, using the Details tool.

9.2.10 Quick Map

Awstralian Capital Territory
lervis Bay Territory

Mew South Wales

Morthern Territory

Queensland

The Quick Map toolbar allows quick navigation to regions, countries and cities. It works together
with the Locator tab to identify the location of the map segment which is currently displayed in the
Map Editor window.

Q: Click on the Q icon to filter the drop-down lists and configure which features will be listed
in them.
Globe: Provides quick access to regions of the world, for example, Asia, Middle East, Europe.
- World drop-down: Select a country
Country drop-down: Select a State or City
Click on the drop-down headings (e.g. World or Australia) to zoom to the corresponding
level (i.e. world or country).
- Type in the text field to search for countries, regions or sub-regions.
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9.2.11 Locator and Preview

Locator Preview

The Locator-Preview tabs display the following information:

Locator

- Select an area and the map will zoom to that location

Preview

If the Map Editor was opened from Viz Artist, Viz Trio or Viz Pilot, the Preview tab will
generate a snapshot of the Viz Scene. For Viz Pilot it will only work if a preview server is
configured.

& Note: The Preview Server URI must include the http prefix (e.g http://localhost:
54000). In Viz Pilot 5.7.x and earlier, check the setting in VizPilot under Options >
Preferences > Advanced > preview_server_uri. In Viz Pilot 6.0 or later, check the
setting in the Data Server under Settings > VCP Parameters > preview_server_uri. For
more information see the section ‘To give applications access to the Preview Server’
in the Viz Pilot User Guide.
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9.2.12 Preset Editor

Right click on the Locator to display a list of predefined regions.
The World

United States
M. America
5. America
Americas
Africa
Asig
Middle East
5. Asia
Europe
United Kingdom
Leslie
Gilad
_Add Curmrent View as Preset k |

Local Edit Presets

Add your own presets to this list by right-clicking and selecting Add Current View as Preset.
Then enter a name for the preset.
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Edit your presets by right-clicking and selecting Edit Presets. In the window that appears,
you can rename, reorder, delete, or duplicate the custom list.

Presets Editor

Leslie

Gilad

Cancel

9.2.13 Multihop Editor

The Multihop Editor allows users to control the number of hops on a template. For example, if a
scene was designed with 2 hops, the user in Viz Trio would be able to add up to 30 hops.

Enable the Multihop Editor
The Multihop Editor is hidden by default, but can be enabled in the following ways:

If a scene contains a Control Multihop plugin, then when the World Map Editor is opened
from Viz Trio or Viz Pilot, it will include the Multihop Editor.

- When a scene in Viz Artist contains the Hops Manager plugin, then pressing the Multihop
button will open the World Map Editor, including the Multihop Editor.

Using the Multihop Editor

Once enabled, the Multihop Editor appears on the right-hand side of the World Map Editor, and
shows all the hops that are defined. The hops can be reordered by dragging them to the desired
place in the list.
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Cylindrical Equidistant Mercator

Cut

Copy

Change Style

Change Project

Duplicate

Remove

A context menu on the Multihop Editor displays the following options:

Cut, Copy, Paste, Duplicate or Remove items in the list.
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Change Style: Select one or more hops and change their style. The change will ONLY apply to
the selected hops.

-

Marathon_DG Street_Bing

s, ¥ r

viprt_Natural_ vizrt_Natural_
Earth_MoRelie  Earth_Seaflp
ha

wurrd_Natural_
Earth

wizrt_Paolitical

Redel Green

& Note: To change the style of ALL hops, use the Select stylesheet button in the
Horizontal Toolbar.

Change Project: Select one or more hops and select a new map template file for these hops.
The change will ONLY apply to the selected hops.

& Note: To change the project of ALL hops, use the Open Project button in the
Horizontal Toolbar.

9.3 World Map Editor Shortcuts

Where you are Shortcuts you can use

While in detail map editor Esc - Cancel edits

Enter - Save edits

While in detail list editor  Esc - Cancel edits
F2 - Start edit
Multiply - Fit to detail
Divide - Center to detail

Minus - Remove detail

Copyright © 2019 Vizrt Page 76



Where you are

While on a list feature

While in preset edit mode

While in shape edit mode

While on first look list

While on main view

While pan tool selected
While zoom tool selected

While shape tool selected

While street tool selected

Shortcuts you can use

Multiply - Fit to feature
Divide - Center to feature
Plus - Add feature

Minus - Remove feature

Esc - Cancel edits

Enter - Save edits

Esc - Cancel edits
Enter - Save edits

Del - Delete shape
Multiply - Fit to shape

Esc - Clear filter

Ctrl + O - Open project browser

Ctrl + S - Save favorite
Ctrl - Zoom tool while key pressed
Spacebar - Pan tool while key pressed

Ctrl - Zoom tool while key pressed

Spacebar - Pan tool while key pressed

Ctrl - Zoom tool while key pressed
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10 Map Designer

The Map Designer is a component of the Viz World Client (WoC). Map Designer allows you to
create map templates similar to those created using Viz World Classic. In comparison with Viz
World Classic, Map Designer offers just the core features, which allow you to design stunning
maps in no time.

Map Designer shares much of the functionality of the World Map Editor, and as such, all shared
features are described in the World Map Editor section, with only the additional features of the Map
Designer covered in this section.

& Note: Currently the Map Designer is only able to work with flat maps.

This chapter contains information on the following topics:

- Getting Started
Map Designer Toolbars
- Stylesheet Editor

10.1 Getting Started

Once you have the Viz World Client installed you can start the Map Designer and connect to the Viz
World Server. Once connected you will be able to open existing design projects, use existing
templates, create new templates from existing templates, or create a template from scratch using
a blank template.
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10.1.1 To start the Map Designer

The Map Designer can be started from the desktop or start menu (i.e. Viz World Design Client), or
from the installation directory (MapsDesignClient.exe):

32-bit system: C:\Program Files\vizrt\Common\Maps
- 64-bit system: C:\Program Files (x86)\vizrt\Common\Maps

10.1.2 To connect to Viz World Server
1. Start the Map Designer

2. Click the Settings button, located on the toolbar.

3. Set the Viz World Server hostname. If not specified, the Map Designer will connect to
localhost.

4. Click Save

10.1.3 To create a map template

Map Designer

w [z

Open From From
Project Template Existing

1. Start the Map Designer
2. Select one of the following options
- Open Project: Open an existing project
From Template: Starts a new project based on a selection of default stylesheets
From Existing: Starts a new project based on an existing project
Blank: Start a new project

10.2 Map Designer Toolbars

The Map Designer has two toolbars, and most of the functions are the same as the Map Editor
Toolbar. The functions that differ are described in this section.

10.2.1 Horizontal Toolbar

Natural Earth ‘3

The horizontal toolbar is the same as the Map Editor Toolbar, with the exception of:

New Project: Create a new map template (see Getting Started)
- Open Project: Open existing map template files.
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- Save Project: Save the current map template file.
- Save Project As: Save the current map template file as a new file.

10.2.2 Vertical Toolbar

The vertical toolbar is the same as the Map Editor Toolbar.

10.3 Stylesheet Editor

Stylesheet Editor
+ 9 ¢

P Land

» Sea

B Miscellanecus

¥ Borders

The Stylesheet Editor is in many ways similar to working with the Styles Editor in Viz World Classic.
You can define styles for land, sea, borders and so on.

This section contains information on the following topics:

- Add and Organize Stylesheets
Customize Styles
Default Values
Land
- Sea
Miscellaneous
Extra Data
Borders

10.3.1 Add and Organize Stylesheets

While working on your template’s style sheets you can Add new or existing style sheets from other
projects to your own project. In addition you can Organize your own style sheets.
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Add

Stylesheet Editor

+ ¥ e

From From Blank
Template Existing

When adding stylesheets you can select one of the template stylesheets, or a stylesheet from an
existing project or simply a blank stylesheet:

From Template: Browse for and select one or multiple existing stylesheet templates and add
them to your project.

From Existing: Browse or search for stylesheets from existing Projects. Select one or multiple
existing stylesheets and add them to your project.

Blank: A new blank stylesheet is added and opened.

Organize

Stylesheet Editor %

Matural Earth

Political - Grey

When organizing stylesheets, the stylesheets in the project are listed, and it is possible to perform
the operations; Duplicate, Rename, or Delete.

Additional stylesheets can be added using the Add button at the top of the Organize window.

10.3.2 Customize Styles

Use the Style Editor to edit and customize the styles of points, lines and areas. These styles can
then be used in your Viz World project.

Open the Style Editor from the Stylesheet Editor toolbar.
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Stylesheet Editor

+E|!.:

¥ Land | Edit Families

Style Editor
#% Styles Editor

World Server

v Familiez B3 Points Lines Defaults Points = Lines = Areas
* E-Regions Point Lakbel

Genernc

Admin 1
News _ : :

Admin 2 = Sub_Region
Colours

Country = Country
Towns

Town = 1K & Town_lk

Regions

- 10K @® = " "
Points of Interest Town > 10K Pu Town 10k

Transportation Town = 100K ¥ = Town_100k

Save Changes Revert

Style families are listed on the left, and default styles on the right. The Style Editor comes with a
predefined list of families and styles that can be used as-is, or can be edited or removed. Drag
styles to reorder them or move them from one family to another.

The styles are global to the system and are available in the World Map Editor, based on what is
available in the Viz scene. Any style in the system that is not part of the scene will be disabled in
the editor, and any style that is part of the scene but is not defined as part of the global styles will
be available in the Others family.
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To create a new style family
1. In the Style Editor, click the New button to create a new family, then give it a name

#¥ Styles Editor

World Server Connect

* Families hk Points  Lines  Areas
= T R |
» E-Regions| Mew Family |

2. Within the family, click the New Style button to add new styles
¥ Styles Editor

World Server Connect

v Families B2 Points  Lines

MyFamily
* E-Regions
3. Fill in the details for the style:

a. Type (point, line, area)

b. Name

c. lcon: Select a new icon in the file browser

d. Color, opacity etc. Only possible for Area and Line.
L4

MyFamily

Label A New Style

R 1
& 130
B: 148

A%

D o13234e7

4. Click Save Changes
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To select a new default style

1. Drag a style from the family list to the default list, and drop it on the desired style.
2. Click Save Changes.

10.3.3 Default Values
Highlight

. Size 30,00 % =

Intensity ® : Resetto “K

38.00 %

Relief Scale

Settings which use the default values have a grey square next to them. If the value differs from the
default, the square turns white. Click a white square to return the values to default.

Copyright © 2019 Vizrt Page 84



10.3.4 Land

Matural
Fill Color
Color "R

Ice Color .

Drop Shadow
Color

Angle

Distance @

Softness @

Drop shadow on
Lakes/Wide Rivers

Marrow Rivers

Relief Shading

Highlight

. Size [ ] 30.00

Intensity @ 30.00

Relief Scale 8.00

Refine Relief

Style

Viz World User Guide - 17.0

The Land settings allow you to define the Style of the map and its fill colors, aswell as the Drop
Shadow and Relief Shading effects.

When defining land styles you first select whether the map should have a Synthetic, Relief or
Natural style.

Synthetic gives the map a basic style, where you can select a single Fill Color or four fill
colors. If you select four fill colors, no country, adjacent to each other, will have the same
color. Both Relief and Natural styles can mix with Synthetic utilizing its single or four color

option. The Ice Color can be set separately.
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Natural gives you the option to select which satellite imagery provider to use (e.g. Google
Maps, Microsoft Virtual Earth, Digital Globe, Planet Observer, and so on). In addition you can
adjust the map’s brightness, contrast, saturation, gamma, and tint.
If the stylesheet uses either Google Maps, Digital Globe or Microsoft Bing, you can set which
imagery profile to use as default. The profiles provide different imagery sets for the same
location. If required, the operator can change the profile from the Map Editor Toolbar when
selecting the desired final location.

¥ Land

Style Synthetic Relief © Matural

Microsoft Virtual Earth

Satellite
Brightness 76.00
Contrast 100.00
Saturation 100.00
Gamma 1.00

Tint 0.00 %

Relief contour colors work the same way as for Sea. It gives you the option to define colors
at varying levels of height (i.e. from 0 to 8000 m.a.s.l.). Clicking below the bar adds a new
handle. Double-clicking a handle will open a color picker for setting a color for that level.
Dragging the handle horizontally will adjust the height parameter. Dragging the handle
vertically will remove the handle.

Style  Synthetic Relief Matural

Drop Shadow

Drop Shadow can be added to land, lakes/wide rivers, and narrow rivers. The drop shadow effect
also allows you to adjust the angle of the shadow, and its distance and softness (spread).

Relief Shading

Relief shading can be added to land. When enabled you can define how the light will affect the
relief by adjusting the highlight (by click and drag). The Size and Intensity settings will help you
control the appearance of the relief texturing on the map.

Refine Relief will add extra detail to the relief. This is especially helpful when zooming in at low
levels.

The image below shows a map with Refine Relief enabled and disabled:
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Color

Contours

Opacity [

Matural Sea

PlanetObserver 15m
Mix with others

Near Mix @
FarMix @
Brightness
Contrast
Saturation

Gamma

Tint

The Sea settings allow you to define the color and/or contour colors of the sea, and when using
satellite imagery how it should mix with the base and/or contour colors.

Color sets the base color of the sea.

Contour colors work the same way as for Land. It gives you the option to define colors at varying
levels of depth (i.e. from 0 to 10000 m.b.s.l.). Clicking below the bar adds a new handle. Double-
clicking a handle will open a color picker for setting a color for that level. Dragging the handle
horizontally will adjust the depth parameter. Dragging the handle vertically will remove the
handle. Opacity blends the base color with the contour colors. The lower the value, the more of the
base color will be shown, and conversely.

Natural sea enables you to select which satellite imagery provider to use (e.g. Google Maps,
Microsoft Virtual Earth, Digital Globe, Planet Observer, and so on). In addition you can adjust the
map’s brightness, contrast, saturation, gamma, and tint.
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Mix with others allows you set the alpha for the mix between the base and/or contour colors and
the satellite imagery. It will mix the colors based on whether you are near or far away from sea
level. Meaning, when you are close to sea level it will use the near mix setting, and when far away
it will use the far mix setting.

Mix with others
Mear Mix L ]
Far Mix

Mix with others

Mear Mix 9

Far Mix
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10.3.6 Miscellaneous

¥ Miscellanecus

Projection Cylindrical Equidistant

Global Map Data

Lakes Medium Lakes

Rivers Major Rivers

Master Size [ ] 1.00

Small Rivers @ 7000 9%

Max Width 200 px

Extra Map Data
Local Street Data

Draw Land

Lakes Maijor Lakes

Rivers Wide Rivers

Lat/Long Lines
Draw on Land
[ ® 200 px

Spacing
long @ 10.00 de

lat @ 10.00 de

Projection:_Map projection either Marcator or Cylindrical Equidistant (Unprojected).

Global Map Data/Extra Map Data: For Lakes and Rivers you can select a base color (no alpha) and
whether or not None, Major, Medium, Minor or All lakes and/or rivers should be shown.

For rivers you can also define:

Master Size affects the width of all rivers drawn as lines.
Small Rivers affects the width of rivers which are classified as minor rivers.
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Max Width (in pixels) determines the maximum line width at which rivers will be drawn. This
is useful if you wish to prevent rivers being drawn as very thick lines as a map zooms in.

When Local Street Data is enabled, the data for lakes and rivers can be displayed.

Latitude/Longitude Lines can be enabled/disabled. The color, width and spacing are configurable.

10.3.7 Extra Data
¥ Extra Data

Local Street Data

Roads All Roads
[ ]

Freeway/Motorway

Primary

Main

Secondary

Other
[ ]

If Local Street Data is used, the Extra Data settings allow the various types of roads to be styled.
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10.3.8 Borders

¥ Borders
Country ® 1.00
" Disputed borders as dashed line

Region [N @ 0.50
Coast o 0.50

The Border settings allow you to define the border color and width (in pixels, 0.00 - 10.00 px). You
can set colors and width for country and region borders, and coastal lines. In addition you can
enable/disable disputed borders. Disputed borders are shown with a dashed line.

Copyright © 2019 Vizrt Page 91



Viz World User Guide - 17.0

1T Map Builder

@ Map Builder - Untitled

Choose Scene Type

W W

Navigator Map

1 Destination  Map Object

g point and up to 32 destinations.

The Map Builder is a component of the Viz World Client (WoC). Map Builder is used during design
in Viz Artist to build maps quickly and efficiently. It is used in conjunction with the Map Builder
Plugin scene plugin.

& IMPORTANT! Prior to using the Map Builder you need To import basic map elements.

In general when creating a map scene your scene will consist of a few basic elements. The
elements are built in the following order:

Create a scene using the Map Builder plugin (see Getting Started)

Choose Scene Type

Create a Base Map.

Define the Global Hop.

Create a Navigator which can be used to create a destination list.

Set the map Orientation.

Configure the design source and object pool Settings.

Use Window to enable or disable a window mask for the scene.

Use Global Borders to generate global vector border data based on the settings applied.
Refresh the thumbnails when re-launching the Map Builder to make changes (see Toolbar
and Menus).

COoxNOUAEWN =

p—
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11.1 Getting Started With Map Builder

421 Map Builder - Untitled

Choose Scene Type

W W

Focus on

Navigator Map

1 Destination  Map Object Open

tor Scene

nt and up to 32 des
lat.

Once you have installed the Viz World Client you can start Viz Artist and create a scene using the
Map Builder Plugin scene plugin. Note that the Map Builder itself will by default connect to the
same Viz World Server as Viz Artist. If needed you can switch to another Viz World Server from Map

Builder’s file menu.

As a first step to work with the Map Builder you can create a scene that only contains the Map
Builder Plugin scene plugin. Once created you can launch the Map Builder by clicking the Launch
Wizard button. This will open the Map Builder and allow you to Choose Scene Type.

11.1.1 To start creating a scene using the Map Builder

1. Start Viz Artist
2. Click Built Ins and then the Scene Plugins tab
3. Select the Maps plugin folder
- This will show the Map Builder scene plugin

4. Click Scene Settings and the Plugin tab
5. Drag and drop the Map Builder plugin onto the Plugin areas placeholder
6. Save the scene
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- Once the scene has been saved you can open the Map Builder and click the Launch
Wizard button to open the Map Builder.

11.1.2 To import basic map elements

Start Viz Artist.

Click Import and select Archives from the drop-list

Navigate to C:\Program Files\Vizrt\Common\Maps\Archives
Select the VizZWorldGlobalDesigns.via archive.

Click Import Archive.

uTh WN —

11.2 Choose Scene Type
Choose Scene Type
w1
Focus on

Mavigator Map 1 Destination Map Object

Mavigator Scene

Scene with one starting point and up to 32 destinations.
Geometry can be globe or flat.

When launching the Map Builder you will be presented with the following options:

Navigator: Allows you to build a scene with one starting point and up to 32 destinations.
Focus on Map: Allows you to create a static scene with a base map only. Can only be used
with flat geometries.
1 Destination: Allows you to build a scene with one starting point and one destination.
Map Object: Allows you to build a scene with one starting point and one destination. The
window option is used so that the map only uses part of the screen.

- Open: Opens existing map template files.

11.3 Toolbar And Menus

11.3.1 Toolbar

New Map Template: Allows you to create a new map template (see Getting Started)
- Open: Allows you to open existing map template files.
- Save: Saves the map template file.
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Save As: Allows you to save the map template file as a new file.

Refresh: Refreshes the thumbnails. Refreshing thumbnails must be done after manually
editing a Map Builder generated scene and when re-launching the Map Builder as all
thumbnails of maps (Base Map, Destinations and Orientation) are lost. In order to refresh
them press the F5 key, or click the refresh button in the toolbar.

11.3.2 Menus

The File menu contains the same functions as the Toolbar, as well as Exit.
Tools menu contains

Refresh thumbnails

Map Server Settings: i.e. Viz World Server host name

Option to enable/disable the tooltips
Help menu contains links to the About information and the User Guide

11.4 Base Map

¥ Base Map Settings

Base Map Type: World Selected Map

2 Map type: Globe Flat
Labels: Mone Managed Managed + Auto
Resolution: HD10BD [+ W: H:

Base Map is the Globe/Flat map in a specific style and data. The map created at this level is usually
good for country level view.

11.5 Global Hop

¥ Global Hop Settings
Hop base duration:

Hop base duration: Distance Based | Per Destination

Hop Min duration (35):

Stop type: Disabled Fly over Stop Points Pause Points

Pause at map start: Enabled Disabled

Camera pan / tile Per Destination Global

Defines the camera’s trajectory animation setting. It describes how the navigation animation
should be (e.g. map start + 3 destination animations, each “hop” animation based on 5 seconds,
with stop points between destinations).
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11.6 Navigator

Navigator Hops + x Mowe w Map Start + 1 Destination

Map Start External Control E

Labels and reguons Map elements - misc
Om Map L

On M b

tination 01  Hop Duration External Control E

Labels and regions Map elements - misc

11.6.1 Type

Type defines whether each destination will be of type Geo Position Only, Map - Single Image or
Pyramid of Maps.

A Geo Position Only destination will only use a Geo Position reference to the navigation. This mode
is useful for destinations that are always far away from the base map. No map will be created in
this mode (as it will save texture memory).

& Note: When destination is set to Geo Position Only, it cannot be controlled by an external
application such as Viz Trio or Viz Pilot.

Map - Single Image enables operators to control a destination using an external application (either
a Map or Pyramid has to be selected). If the selected destination is used for a reference point, and
it needs to be controlled, use this type (e.g. a far away starting point).

Pyramid of maps is used when the base map is not suitable for close-ups. A pyramid of maps built
around the destination will smoothen the resolution difference between the base map and the
destination target.

11.6.2 Destinations

Each destination can consist of map elements (labels, regions and miscellaneous map elements).

If destinations are controlled (e.g. by Viz Trio or Viz Pilot) they can be linked to each other - to
allow the user to easily control multiple destination elements. Linking is only a help to the user
and has no effect on the scene.
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Copying (duplicating) a destination is possible by selecting a destination and clicking the add
button.

& Note: The selected destination will not be duplicated if the destination type is Geo Position
Only.

11.7 Orientation

¥ Orientation

" Add orientation map

Center Map  Locator

The Orientation map is displayed in the bottom corner of the screen. It consists of a small map
with a marker showing what part of the world is currently being navigated to.

There are three views available:

Center Map: The orientation map will be moved according to the main map’s geographic
properties

Locator: A marker on the orientation map will move according to the main map’s geographic
properties

Globe: A globe will rotate according to the main map’s geographic properties.

11.8 Settings

¥ Settings
Designs source: In Scene Object Pool

Objects pool path: Default Custom

User folder:

Map Layer: 2nd Layer Dynamic

Allows the user to specify the design source and object pool path.

Designs source is an option that allows designs to be shared between scenes by using the Object
Pool, instead of the in-scene designs.

Object Pool Path: The default object path is /vizrt/vizworld/GlobalDesigns. This option allows
users to specify an alternative Viz Graphic Hub or Object Pool folder. A custom Object Pool Path
must use the same hierarchy structure as the default object path.

Map Layer: Select whether the scene will use the Front and Main layers, or will only use the Main
layer and then apply a Dynamic texture for the overlaid items.
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11.9 Window

¥ Window

U=e Window Contral Window Mask

X
Y:
Width %:
Height %:

When this option is enabled the Map Builder will add a window mask to the Viz Scene and also
apply the X, Y, width and height values to it.

11.10 Global Borders

¥ Global Borders

World: Mone

Region Data: @

Region List: Africa

Country Borders:  Internal Coastline

This option will enable Borders as vector shapes in the scene.

World: Select whether to create full world vector borders or not

Region Data: Additional regional data up to the resolution selected (Country, Region,
SubRegion)

Region List: The regions that will be built are based on the selection in this field.
Country Borders: Select whether to generate Internal Borders, Coastline Boarders or Both
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12 Map Editor Classic

The World Map Editor (WME Classic) is a component of the Viz World Client. WME Classic can be
integrated with numerous Vizrt products that enables users to select, frame and populate maps
and use them in Viz. The WME connects to the Viz World Server and retrieves the map to be used.

This section contains information on the following topics:

Map Editor Classic

Using the Map Editor

Map Name Editor

Using the Map Name Editor

12.1 Classic Map Editor
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The WME window includes the map area, navigation and map editing area, map details area and
the map tool bar. The user can select (zoom and pan) a region on the map, or use the search tool
to find the requested location. The user can add information to be displayed over the map by
selecting objects from the database or by manually marking a place on the map. The added
objects are displayed in the Map Details area.

This section contains information on the following topics:

Map Area

Navigation and Map Editing Area
Search Tab

Explorer Tab
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Extra Data Tab
Symbols Tab
Map Tool Bar
Map Details Area

12.1.1 Map Area

The map area displays the current map and enables the user to modify the map interactively,
according to the selected tool in the buttons toolbar and by using the integrated Zoom Options.

Context Menu

Guides Screen Safe

Languages Title Safe

Server Pricrity Logo

Background

Guides: Allows you to display default guides (e.g. safe and title area) or custom guides and/
or images (e.g. logo and background). For more information, see how To add custom
guides.

Languages: Defines the language setting for labels. See the Server Configuration tool’s
Display section and how To create a new language file.

Server Priority: Sets the connection priority given by the Viz World Server. See the Server
Launcher Configuration section and the Enable Priority Login option. If you are working on
scene design using Viz Artist, Viz Artist also needs to be configured (separately). See Viz
Artist’s Maps Configuration section.

To add custom guides

With custom guides you have three options; two for placing an image as a background or logo and
one for placing guides such as title and safe area boxes.

1. On the Viz World Server machine locate and open the CustomGuides.txt file under
32 bit: C:\ProgramData\Curious Software\Curious World Maps\Settings
64 bit: C:\ProgramData\vizrt\Viz World\Settings
2. Enter the following to show an image (e.g. logo) on top of the map:
Syntax: Type "Title" Ratio Width(%) Height(%) "Filename" Image X(%) Image Y (%)
Opacity (%)
Example: Image "Logo" 1.333 80 80 "C:\logo.png" 0 0 75
- This will add an image on top of the map, the image will be applied with 75% opacity
(alpha is supported).
3. Enter the following to show a background image on top of the map:
Example: Image "Background" -1 90 90 "C:\background.png" 5 5 25
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- This will stretch background.png to fit the current aspect ratio (-1) with 5% on each
side as margin at 25% opacity.
4. Enter the following to add a custom guide to the map:
- Syntax: "Title" Ratio Width(%) Height(%)
Example: "4:3 Title Safe" 1.333 80 80
- Valid width and height values have to be between 50 and 100. Set ratio (width divided
by height), or -1 for current aspect ratio. You can define up to 5 custom guides.

Zoom Options

In the upper left corner of the Map Area there are two rectangular blue shaped buttons that can be
used to zoom in and out of the map. In addition it is also possible to use the mouse (left button)
and/or in combination with the keyboard.

The zoom options, besides menus and buttons, are:

Drag and draw a rectangle to zoom in to fit.

Click the left mouse button to zoom in.

Hold down SHIFT to zoom out.

Hold down CTRL to zoom in in smaller steps.

Hold down CTRL and ALT to zoom out in smaller steps.

12.1.2 Navigation and Map Editing Area

The navigation area enables the user to locate places by searching the database or selecting a
place from the explorer list. When a place is found (or selected) the user can fit the map to the
requested area, add information to the map, highlight the region and modify the map.

Using the Results

After conducting a search or using the explorer, the results will be displayed as a list. When an
entry is selected, the buttons on the right side of the list will become enabled:

P Add to map: Adds the selected entry to the map. The selected entry will be added to
the map graphically as defined in the selected map style. A map style defines map symbols,
fonts, icons, colors, and so on. For map styles see also Map Tool Bar and the Map Style drop-
down menu.

n Center map: Pans the map to center the selected entry (keeping the current map scale
size).

m Fit to fill: Centers the map and scales the map to fill the map area.

@ Show details: Opens the browsing tool, which displays the context information for the
selected detail. The context information includes the regions containing the detail (that is
country, state and county) and the capital of that country.
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12.1.3 Search Tab

search | Explorer | Extra Data || Images | Symbols
Find.  &al (O isible
Search: Paris T
Crosz 5t

Type: |4l * 5 Durce:‘a -
All

tap DB
T_|Name ExhiaData
&?‘l Paris, Larmar County L= l:?

f:i Paris, T United...ates, Larnar County

The search tab is used for searching the database for a place, using a string or sub string typed in
the name text box. The search results can be filtered using the radio buttons and the drop-down
list.

Searching is instant (after the first three characters) and optimized according to relevance; hence,
if you search for Paris your result will show all places named Paris, but if you search Paris TX you
will get Paris in Texas, USA.

Search | Explorer | Extra Data || Images | Symbols
Find: A1 (O Visible
Search: broadway ANMD 44
Cross Sk

Type: | Al = 5 u:uuru:e:l Al Ad

T |Mame |
<1> Broadway & W 44,..ew york new york

- 2
]| Broadway, new york new york
|ﬁ| W ddth St, new york new york [ﬂ

If you have street data (see Extra Data Tab) you can also search for crossroads using AND or &
(e.g. Broadway AND 44th).

Search Parameters

Find All: When selected it displays all matching entries in the database.
Find Visible: When selected it only displays matching entries visible in the current map.
Addr and Cross st.: Enables the user to search for specific addresses.
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Type: Limits the result list according to the selected Type. For example region, capitals,
tourist attraction, and so on.
Source: Searches a range of sources.
All: Searches all sources.
Internal: Searches the map database and extra data.
Map DB: Searches the Viz World database.
Extra Data: Searches all extra data packages bought in addition to the standard
installation (see Map DB).
Web: Searches Yahoo for online point data.

& Note: Searching for addresses requires licensed street data installed on the
server.

12.1.4 Explorer Tab

Search | Ewplorer | Ewtra Data || Images | Symbols

[ ]izible _
—|- Canada - ‘

alberta i 2
British Columbia |::|
Manitoba =
Mew Brunswick
Mewfoundland and Labrador =
Maorthwest Territories
Mova Scotia -

| Towns > 100k v | <Filters

Type Mame

E Abbotsford, British Columbia

a‘ﬁ Burnaby, British Columbia

%‘_j‘ Coquitlam, British Columbia

35; Kelowna, British Columbia

E Langley, British Columbia

a‘ﬁ Morth Vancouver, British Columbia
%‘_j‘ Richmond, British Columbia

35; Saanich, British Columbia

E Surrey, British Columbia

'__'i] VYancouver, British Columbia

%‘_j‘ Victoria, British Columbia

The explorer tab is used for selecting a location from a list of places derived from the server’s
database. The list is displayed in a tree format showing countries, regions, cities, and so on.
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Explorer Parameters (list filter)

Visible: Only displays location entries visible in the current map.

Type: Limits the search result list to the selected type like region, capitals, tourist attraction,

and so on, when one of the entries in the list of available types are selected.
Filter: Filters the search result further.

& Note: To find New York, type N, then type E, etc. with every character typed in the
string filter the list will be smaller.
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Searchl Explorer  ExtraData |Images| Syml:unlsl

Data... |

[ wisible Irpart KRL... I

- Telemark, Mo
- Teramo, Abruzzo, It
- Tromsz, Mo
<est-Agder, Mo
- Westfold, Mo
- Wibo Walentia, Calabria, [t
- kML Files
- tdf2008 kil

) s

[~ wisible <Filters

| MName ¥

7

Alversund
Alvaen
Askay
Austevoll
Austmarka
Austrheim
Bekkjarvik

OO0

i

Bildgyna
Bjgrgum
Blomsterdalen
Brattholmen
Bamla
Bammelhawvn
Dale
Dimmelswvik
Eidfjord
Eidsvag

OO0 OODOOD

Eikelandsosen

.ﬁ.ddressl Intersectinnsl Back |

™
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The Extra Data tab is used for selecting a street from the streets database on the server, and
Keyhole Markup Language (KML) files.

& Note: Streets data requires additional license features and the installation of street data on

the server.
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Streets

Search] Explorer  ExtraData |Images] Symbnls]

[ “izible Impaort kL. | Data... |

-1 Hordaland, Mo -
- Streets '
b akanmans
Prirmary Roadz
M ain Roads:
Other Roads
+- Land Use &
+- Land Use B bt

63 R |

[ %izible furulizn

Type MName |
~ Furulien

B

Interzections | |

Streets data is available from the Streets node, and are sorted by Motorways, Primary Roads, Main
Roads and Other Roads. Use the Filter search to search for streets.

Import KML

Search] Explorer  ExtraData llmag m

[ Wisible w =- Touwr de France 2008 ~
+- Telemark, Mo Stage 1 start )
+- Teramo, sbruzzo, |t Stage 1
+- Troms, Mo Stage 1 finizh
+- West-hgder, Mo Stage 2 start
+ R-"gstfu:uld, NF‘ _ Stage 2
+- Yibo "-.-"Talentla, Calabria, It Stage 2 finish
—|- kML Files Stage 3 start

tdf2008._kml Stage 3 -
[l RS ) HP By g
A <Filter:
| “izible ﬂ
Type Mame

Keyhole Markup Language (KML) files can be imported and added to the map. The KML data will be
accessible from the Extra Data tab as with street data. By clicking the KML Files node, all the
imported KML files will appear as sub nodes. Click one of the imported KML files to open the KML
file window the respective file will be file.

KML files currently must be manually imported into the server. Files are placed in the following
location:

32 bit: C:\ProgramData\Curious Software\Curious World Maps\KML
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64 bit: C:\ProgramData\vizrt\Viz World\KML

12.1.6 Symbols Tab

Symbols are added using Viz World Classic, and can be imported using the Configuration tool or
Viz World Classic.

To add symbols

Start Viz World Classic, preferably on the maps server.

Create or open a map project.

From the Tools menu, select Symbols.

In the Symbols dialog box, click the + symbol (bottom) to search and select for a symbol.
Close Viz World Classic.

Restart the Viz World Server to load the new images.

oV wN =

& Note: Images should reside on the map server or on a shared drive.

12.1.7 Map Tool Bar

IDigita|G|obe v][ vl Reglon Pick Browse Move Add Add Edit Locators
Zoom Zoom Pan | Feature Map Label Label Streets Shape  Shape

BEE - ) (0] & B0 8 P

The map tool bar includes a row of buttons controlling the map interactive mode. The map area
enables an interactive map selection and manipulation and the map tool bar is used for selecting
the map interactive behavior.

Map Tool Options

- Available Map Stylesheet: Displays a list of available map styles of the selected template.
Select a map style to apply the style’s design to the displayed map.

- View Presets: Displays a set of view presets. Available options are: The World, United States,
N America, S America, Americas, Africa, Asia, Middle East, S Asia, Europe and United
Kingdom.

= Open New Template: Loads one of the defined templates installed on the server
creating a blank map with the template’s styles and settings. When pressing this button a

confirmation window will open. When confirmed, the template window will open. Select one
of the projects in the list and click OK. A new map will appear in the map area using the new
template’s default styles and settings.

=

Save Favorite: Save map as a favorite.
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& Note: User favorites will not be synchronized across servers when working with
server allocator. When working with multiple servers, synchronizing user favorites
can be done as an automated process of replicating the relevant folders. User
favorites are stored by default under C:\ProgramData\Vizrt\Viz
World\Users\Default\Favorites.

9

@:D Redo button: Cancels the last canceled change on the map.

Bird’s Eye: Displays the available imagery Bird’s Eye imagery from the Bing Maps Platform.
When clicking the button, the imagery for the area of the current map will be displayed
enabling the user to select an image for the map.

: E Quidk Map
Set Location

Undo button: Cancels the last change on the map.

Quick Map: Opens the Quick Map location browser that enables the user To create a map
using the Quick Map location browser.

Set Location: Opens the Set Location dialog which enables the user To set the map
location using longitude, latitude and map size values (radius around the defined point).

ﬂ Region Zoom: Enables the user to click and drag the mouse on the map to create a
rectangle surrounding an area on the map (rubber band).
The rectangle displays two icons; a cancel icon in the upper right corner and accept
icon in the lower left.
The rectangle keeps the aspect ratio set for the map unlike regular zoom (see below).
Region zoom can be adjusted before accepting the area selection.

E Zoom: Zooms into the map on every click on a point in the map centering the clicked
point in the Map Area. Another option is to drag and create a selection area. When the
mouse button is released, the selected area will become the selected map. Selecting an area
using the zoom option does not maintain the aspect ratio.

& Note: Both Region Zoom and Zoom allows for area selection in the Map Area;
however, Region Zoom will maintain aspect ratio and allow the user to cancel the
operation after the selection was made.

@ Pan: Enables the user to click and drag on the map to move the map in the direction
of the drag.

g Pick Feature: Shows a group of available places from the database as “phantom
labels”. This feature enables the user To pick a label and add it to the map. The labels will
appear over the map only when an entry is selected in the explorer tab or in the search area.

@ Browse Map: When clicked any click on the Map Area will update the browse window
with context information for the clicked position. The context information includes regions
containing the position (for example country, state and county) and the capital of the
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country.
" —
Browse

Features

& i
Q\.} Toscana
G Arezzo

?h- Foma (Rome), Roma

Qm (2]
| H-l Gﬂi?l Close I

I H Move Label: Enables the user To move a label in the Map Area. Map Label enables
the user to move the tip and the caption of user-created labels or to rotate them. In other
labels only the caption can be moved and rotated.

& Note: Rotation of labels in WME will not effect label objects generated by Viz (3D
labels). The rotation is noticed only when using labels as part of the map texture.

El Add Label: Adds a label at the click point, enabling the user to enter and select a label
text and label icon type.

-,

"New Detail

Mame: I My Flace

Style: IF'Iau:E ;I

v Remember label and publish to all user

QK I Cancel |

Remember label and publish to all users: When this option is checked, the new label will be
added to the database. Whenever the place is selected all the customized labels will be
available for selection by the user. When the option is unchecked, the modified label will be
used only by the current map.
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ﬂ] Streets: Enables the user to select and label streets on the map. Street data must be
loaded for this feature to work (see Extra Data Tab).
acidwhale | s whoe Wish Label

i Secton | add Secton vt Label

Al sl

Nostegaten

- Add Shape Adds shapes to the map. Select between pomts (stralght) and bezier (curved).
Selecting the Add Shape button also opens a small toolbox for selecting shape designs.

Mﬂ \\/ Points
(

Available options are:
- Area: Fills the drawn shape, and will also close the line (see Closed Line).
- Closed Line: Allows the user to close the shape without setting the final point (e.g. 2
points will draw a third closing the line with the first point).
- Open Line: Allows the user to draw a line that is not closed.
Delete Last: Deletes the last drawn line.
Cancel: Cancels the draw operation.
Edit Shape Allows the user to edit the shapes and streets added to the map. Streets (roads)

can be offset, while shapes can be adjusted using the Point toolbox that appears when the
Edit Shape button is selected.

T

‘]\ Offset Road

& Note: Shapes and streets can be edited further using the maps plugins (e.g. 3D Line
and 3D Line Manager).
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To create a map using the Quick Map location browser

L —-E
o — N —
wa [a] |Mu | Typs | Hame ¥

oon

& Tongrhou, Beifing

|

ﬁ,ﬂ, i‘l’mnu}iﬂl]k ';IE

k3

1. Click the More button’s Quick Map option in the WME.
2. Select or search for a country in the Country list.
- The map area will fit to the selected country and the State/Region list will show a list
of available regions of the selected country.
- When a country is selected in the list, the Add to map and Mark Area buttons will be
enabled.

3. Select an entry from the list, the County/sub region list will be filled.
4. Click Finish to close the location browser and create the map.

& Tip: Clicking the Search button switches the Quick Map tool to the search tool mode.
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To set the map location

Set Location

Long, (%) 114.0000C
— Kilometres

Lat, ) IZE.EIEIEIEIEI _l? ::IEEES
ards

Radius I 360.00 ill II‘GIDmetres

Zancel

B A

1. Click the Set Location button in the WME to open the Set Location dialog box.
2. Enter the longitude, latitude, and map size radius in miles, kilometers, meters or yards.
3. Click OK to calculate and display the map in the Map Area.

To pick a label and add it to the map

[ Witible ||:|.=;,.;..-.' = |4F|||a|>
Type Mame ¥

Eah
Bangha-Belioung
Banten
Eengkuly
Goranksls
Jakarka Raya

- GOOOON

Perform a search and select a location.
2. Click the Pick Feature button to display all the phantom labels for the selected area.

3. Click a label to add it to the map.
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To move a label

Pick. Browse Maove Add Add Edit
Feature Map  Label Label |Streets Shape = Shape

B (@) () Bt ™

Maove Label Poink

1. Click the drop-down button to open a list of options.
2. Select one of the options and then select a label on the map and move the label around in

the graphic display.

12.1.8 Map Details Area

tap Detailz

ek

Austria

G

)

Sweden

:

Israel

Thailand

J

)

England

C
&]

R % | & |8

Style: I Selected Reqgion ;I

Faont Size: |12 vI [T AllCaps

The Map Details area displays a list of all the added locations over the map. The user can modify
the map, by selecting one of the added places and the control buttons on the right side of the map
details area.

Map Details parameters

Style: Sets or modifies the graphic display representing the selected place on the map. The
style selection will affect the highlighting color used to mark the selected place, the label,
and so on.

Font Size: Sets the font size used for the label in the graphic display. Font size is only
relevant for the display in the editor and for text labels that are exported as part of the map
texture; hence, it will not affect the size of labels rendered by Viz.
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- All Caps: Uses only capital letters in the graphic display when showing the selected place’s
label.

alas Rename label button: Opens the Rename Label dialog box that will allow the user to
customize and add other labels to the database by entering a new label for the selected
place or by selecting an existing label from the list of labels or modifying an existing label.

- Remember change and publish to all users: When this option is checked, the renamed
label will be added to the database. Whenever the place is selected, all the customized
labels will be available for selection by the user. When the option is unchecked, the
rpodified label will be used only by the cgrrent map.

Rename Label

| My Place ﬂ

| Remember change and publish to all users

2k | Cancel |

& Note: The label will be used in the graphic display and in the map details area.

Delete place from map: Removes the selected entry from the map (and from the map
details list).

Delete all places from map: Removes all added places from the map (and from the map
details list).

12.2 Using The Map Editor

This section describes how to use Viz World’s Map Editor (WME) with Viz Artist, Viz Pilot client
(which includes how to use Viz Template Wizard and the Newsroom Component), Viz Trio and Viz
Weather.

This section contains information on the following topics:
- To test with Viz Artist
- To test with Viz Pilot

- To test with Viz Trio
- To test with Viz Weather
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12.2.1 To test with Viz Artist
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Viz Artist requires no additional setup as long as the Viz World Client is installed, and the map
server settings in Viz Config’s Maps section have been activated.

n'\ﬂrl:ull:u:'ilipu'.lznl

1. Open a map scene

2. Locate and click the CWMClient icon in the tree structure to open the CWMClient Editor.
3. In the editor, click the Viz World Map Editor (WME) button to open the editor.

4. Search and select a map, and click OK to add a map to the scene

& Note: Make sure that ControlMap plugins are placed on the same containers as the
CWMClients in order for Viz Pilot to be able to change their maps.
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12.2.2 To test with Viz Pilot

0 Vi Temglate Wizard v, 5.3.0 - Database: VIZ-xwd J00/D0C
B Bk Wew VpBEngre Toss Hep

Viz Pilot’s map server parameters are stored on the Viz Pilot database. The parameters can be set
or changed using the Viz Pilot client (Options > Preferences > Viz World).

For an operator or journalist to be able to change maps, the map scenes must use the ControlMap
plugin. Also, before the scene can be used in the Viz Pilot client or Newsroom Component a map
template must be created using Viz Template Wizard.

1. Start Viz Template Wizard

2. Import a Viz Artist map scene to the Viz Template Wizard
If a ControlMap plugin is used by the designer an image component will be
automatically added to the template

- A template user clicking the image component will then be able to open Map Editor to

select a map

3. The ImageSources property should be set to IsAdvancedCuriousMap

4. Save the template to a concept

Once the template is stored it can be opened by the Viz Pilot client or Newsroom Component.

Copyright © 2019 Vizrt Page 116



BV Eontent Flot 5. 5.0 - Uhier: i - Datakans: viz-aowd J0Uo: - MSE- Incalsoat

Mie Bl Opfom ek Valngee Wirdews Help
_— -

FeL -

Viz World User Guide - 17.0

==

Bereh | Englore | Samen | T |

Frd & M 7 ikl

e

waat [

C -
Erw:h I

Tust  [roeeT l

L
Marcharter
Uil

popk

Londee

S | =]
Fu!Bbu:| "I [ w5 o

for e poarod,

1. Start the Viz Pilot client or Newsroom Component, and open the newly created template.
2. Click the image in the template to open the WME.

3. Enter a search criteria (for example London)

4. Select London City, England from the list

5. Tick London City, England, and click the zoom button (map icon) for England

6. Click OK to close the WME.

7. Save a data element of the template and add it to the playlist.

8. Play or preview the scene on a local Viz Engine renderer to see the map animations.
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12.2.3 To test with Viz Trio
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Viz Trio’s map server parameters are set by the local Viz Engine that Viz Trio uses to render the

scenes locally; hence, there is no need to configure Viz Trio.

Start Viz Trio

Select Import Scenes from the drop-list in the Editing window.

Locate and import a tutorial scene to create it as a Viz Trio template.

Select and double-click to open the newly added template.

Click the Browse Viz World button to open the editor.

Enter a search criteria (for example London)

Select London City, England from the list

Tick London City, England, and click the zoom button (map icon) for England
Play the scene in Viz Trio so see the map animations

WoONOUVAWN =
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12.2.4 To test with Viz Weather
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To enable Viz World capabilities add the following entry to the Viz Weather INI file:

A S 1l i AN

FA00e. 181 AR
ARG LTS A T
A k2 FH

[CURIOUS]
cwm_enabled=y
simplified=n
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wENOW

11.
12.

Open a map enabled scene in the editor
Click the Map button on the editor toolbar
Click the Map icon to select a map
Select From Server
- When selected, a full version of the map editor opens
Select a map project
Enter a search criteria (for example London)
Select London City, England from the result list
Enter a new search criteria (for example England)
Select England from the result list

CIEIEY

Adjust the view and style of the map
Use the map buttons (lower right) in Viz World Client

Click OK to close the map editor.
Play the scene in Viz Weather to see the map animations.
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12.3 Map Name Editor

1" Map Names Editor

World Server localhost Connect

P Word b

Capital Region Town = 1M Town = 100K Town > 10K = Town > 1K Crther

Democratic F:Ep-uhﬁn: Democratic F'.-_-F-uhl ] jrhiy :I_.le'fﬂ:_-?;fﬂlﬂ I:nl.lntr,r

Demmark Denmark T ] o Country

t{lih-.'auh r.'l_ill'.-uu'll WNIXX . s 1| Cou ntr_\r

Daominica Dominica AhE Country

Dominican Republic  Domimican Republic FEE=hHE Country

East Tirmor East Tirnor E? =) ;F.:EF_IF Cou ntry
Ecuador Ecuador I2FFILAHE | Country
Egypt Eqypt O 1=n T= T - P | Country
El Satvador El Sabvador WIXI0 I 30 Country
Equatorial Guinea Equatarial Guinea TPITSTIN TINT FEF—FHHE | Country
Eritrea Eritrea DRI U kRUFE Country
Estonea Estoma i IIIDN LA E'-__."'-l:.'_-.il 1= i Znurdr:,r
Ethiopia Ethiopia TOTTIN IFAL 7FEEET | Country

Shoan g

The Map Name Editor is a batch feature translation tool meaning that you can use it to edit
multiple language translations stored at the Viz World Server.

World Server: Allows you to connect to the Viz World Server using either hostname or IP
address. Click the Connect button to connect with the server.

Once logged in you can display all features at four different region levels; World, Country, Region
and Sub Region level. However, this depends on the levels available for each country (e.g. the
United States of America has all four levels, while Oman only has three levels).

Once you have chosen the regional level you want you can further filter your result or select one or
several of the pre-configured layer buttons.
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F World »

Capital Region Town > 1M Town > 100K Town > 10K = Town >

v DB Mame
Democratic Republic  Democratic Republic o nz Country
Alternate Mame =

Jderimar i T g —+ Co ’
Denmark Denmark User Name [ralilp 3 { Country
Dyjibouti Djibouti v Abbreviations oA 1= Country
Dominica Dominica German = Country

Dominican Republic  Dominican Republic ¥ Hebrew A Country

East Timar East Timar s "‘1];"“"':""". T ET=JLETE Country

w Ta =
Ecuador Ecuador liie- ITLFFIHMNE  Country

Egypt Egypt omMn T2 - PS03 Country

If you right-click the column headers you can display different columns. The standard columns are
Display Name, DB Name, Alternate Name, User Name, Abbreviations and Type. In addition you can
add you custom language alternatives and choose to display them using the context menu.

See Also

Using the Map Name Editor

12.4 Using The Map Name Editor

This section describes how to use the Map Name Editor. See the following sections for more
information:

To create a new language file
To add language specific translations
To use the new language file

12.4.1 To create a new language file

1. Start Windows Explorer

2. Create a folder named Languages in the following location:
32 bit: C:\Program Files\Curious Software\Curious World Maps\SharedData
64 bit: C:\Program Files\vizrt\Viz World\SharedData
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3. In the folder you can either place an empty file called <my language>.mdx or copy and
rename UserNames.mdx (if you already have changed a lot of the label names)

P World P Belgium P Bruxelles

Capital Region  Townlm TownlOOk TownlOk  Townlk Other

Anderlecht Anderlecht Town 10K

Brussels Bruxelles _ Capital

4. Start the Map Name Editor executable found under
64 bit: C:\Program Files\vizrt\Viz World
5. Edit the new file
- Your language will be added as a new column
6. Click Save Changes

12.4.2 To add language specific translations

Start the Map Name Editor

Connect to your Viz World Server

Right-click and select your language column representing your custom language file
Search for the name that needs a language specific translation

Enter the translation and click Save Changes

uThWN —

12.4.3 To use the new language file

1. Start the Server Configuration tool and log on to your Viz World Server

2. Select the Maps’ Display section

3. Set the Alternate Label Display’s first option to be M-Language (multi-language)

4. Start for example Viz Artist, create a maps scene and launch the Map Editor (WME)

Guides

Languages English
Server Pricrity v Morwegian ™
o|Brissel [ ¥

5. Right-click the map area and select your language from the appearing context menu

& Note: Setting a language in WME does not affect the language used in Viz Artist.

6. For Viz Artist add/edit the VizWorld.ini file under C:\ProgramData\Vizrt\viz3\Maps and add
the following entry:

language=[my Language ID]

7. or (dynamically) send the following command to Viz Engine:
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MAPS LANGUAGE [my Language ID]

& Note:my Language ID refers to the order in the list of languages, English = 0,
Norwegian = letc. See the above screenshot.

See Also

Map Name Editor
Display
Maps Configuration
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13 Photoshop Plugin

The Viz World Photoshop Plugin is used to integrate Viz World and Adobe Photoshop files. Maps
created with the Photoshop Plugin will create a new file with separate layers for every feature and
detail on the map.

& Note: The Photoshop Plugin must be installed separately, see Installing Photoshop Plugin.

e Edit Image Layer Type Select

AuferSalort: Graip 3

New Map @ 40% (Map Layer “BORDE

Algeria

Lk B & 5 B Rl o | -

Dioc; 43503084

Timeeline

Creabe Video Timelne

This section contains the following topics:

Working with the Photoshop Plugin
Photoshop Layers
Viz World Settings in Photoshop

13.1 Working With The Photoshop Plugin

Once the plugin is installed, you will be able to open Map Editor Classic from within Photoshop.

In Photoshop, go to File > Scripts and you will see the Viz World options.
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The options that the plugin adds, are:

- Viz World Map Editor
- Opens Map Editor Classic.
- Select a TPL, style, and so on, then browse and add details to your map.
- After making your selections and clicking OK, a new Photoshop file will be created
with all the layers of the different features and details on the selected map.
- Viz World Refresh Map
- Opens Map Editor Classic with the selections and map from the previously generated
Photoshop file.
Modify your selection, add details to the map, and so on.
- After making your selections and modifications and clicking OK the changes will be
applied to the existing Photoshop file instead of creating a new file.
- Viz World Save As Geotiff: Save the file as a GeoTIFF file (a TIFF file which includes
georeferencing information)
- Viz World Setting: Opens the settings window

13.2 Photoshop Layers

The Photoshop Plugin creates 5 layers in your Photoshop file. The following two layers are always
created:

- All Layers (a raster image of the final selected map)
Base Map (a raster image of the land and sea without any selections)

The remaining three layers can be configured in the Viz World Settings in Photoshop window.

13.3 Viz World Settings In Photoshop
To open the Viz World Settings, go to File > Scripts > Viz World Setting

-

- Server Name: Viz World Server Host name
Layer 1/2/3: The Photoshop Plugin creates 5 Photoshop Layers. Three of these layers can be
configured here by selecting the features that should be included.
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14 Open Street Map Downloader
The Open Street Map (OSM) Downloader is a tool for downloading street maps from the Open
Street Map initiative.

The street maps are prepared by Vizrt and can be downloaded from the Vizrt FTP at
download.vizrt.com. In order to get access you need to sign up for an account. Please contact your
local Vizrt representative for more information.

This section contains information on the following topics:

OSM Downloader Interface
Working with the OSM Downloader

14.1 OSM Downloader Interface

48 0SM Downloader 17.0.0.14922

¥ Vizrt FTP Credentials

Username Username Password sssssssss Remember me Use Proxy D‘ S

> Complets * v + 118GB

Available Files

W Africa (207.2 MB)
W Americas (4.5 GB)

Wl EastAsia (1.3 GB)

Download Queue

Destination Folder C:\ProgramDatahVi iz ) \\MapData\StreetData W Reset

Download

14.1.1 Vizrt FTP Credentials

Username and Password: Your Vizrt FTP username and password.
Remember me: Allows the tool to remember your username and password for the next OSM

download session.

Use Proxy: Enter the Proxy Server hostname, Port, Proxy User and Proxy Password if using a
proxy.

Connect: Allows you to connect to the Vizrt FTP and the Viz World Server

Refresh: Allows the Viz World Server to update the street data after the OSM data has been
downloaded.
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14.1.2 Select Files

Breadcrumbs navigation: Allows you to select the street data you want to add to your
download list.

. Add €: Select a street map from the drop-list and then click the + button to add the item to

your download list.

- Available Files: Lists the files that are available on the server.

14.1.3 Download

Download Queue: Lists all OSM items ready for download. You can also check/uncheck each
download item. If you want to delete items from the queue you simply select an item and
press the Delete button or click the right mouse button.

Destination folder: Defines where you want to keep the downloaded data on local disk. Note
that the Viz World server expects the files to be in the default folder (see how To configure
the OSM Downloader).

Download: Start downloading from ftp to local folder.

14.2 Working With The OSM Downloader

14.2.1 To install the OSM Downloader

The OSM Downloader must be installed alongside the Viz World Server. This is done by installing
Viz World Client components on the server.

uTh WN —

Run the Viz World Client installer

Select Custom

Select the Viz World Server Config component
Click Next

Click Finish

14.2.2 To configure the OSM Downloader

Before the open street maps can be downloaded and used by your designers you need to configure
the Street Data location.

a

uTh WN —

Tip: Both tools can be started from: C:\Program Files\vizrt\Common\Maps

Run the Viz World Server Configuration tool

Connect to your map server

Select the Maps -> Locations section to configure the Street Data location
Run the OSM Downloader tool

Set the Destination folder to match the Street Data location
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14.2.3 To download open street maps

Before you start to download open street maps you need to have a Vizrt FTP account, aswell as
have the software installed and configured.

Run the OSM Downloader tool

Make sure you have a connection to your map server
Enter your Vizrt FTP account credentials and click Connect
Browse and select data

Click Add € to add data to your download queue

When done, click Download

oviewN =

& Tip: Before attempting to connect, make sure the destination folder is configured correctly
to match whats configured for Street Data location in Viz World Server configuration, and
user has write privilege to that folder.
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15 Geographically Referenced Maps
Server Built Ins Control Views Tree
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CWMClient plugin produces geographical maps (geo maps). Geo maps are images of maps that are
geographically referenced (that is the image contains information about its longitude and latitude).

Geo maps are identified by a little globe icon next to the image icon. Containers that will be placed
under the GeoMap container and using geographic data referencing will be placed relatively on the
GeoMap.

& Note: Do not modify the image properties.
Do not scale, rotate or change the position of the image in the image editor. Changing any of
these parameters will result in loss of the image’s geographical reference.
All modifications should be done in the container properties editor.

The geo map can be placed on any Geometry Object; however, the geographical referencing will
not be correct when placed on 3D objects other than Globe. It is recommended, for best
geographical referencing results, to use Geolmage, Globe or terrain objects.
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16 Viz World Plugin API

The Viz World Plugin API offers an easy to use geo-reference capability when building your own Viz
Artist plugins. The API allows you to communicate and manipulate Viz World scenes and get
Navigator Plug-in information.

This section contains information on the following topics:

- Working with the API
Best Practices

16.1 Working With The API

This section contains short descriptions on how to use the APl and what it does.

16.1.1 VWPosition

Can be used to position a container based on a longitude/latitude coordinate on a geo-referenced
map.

To use VWPosition

1. Add a geo-referenced map on a container (using Geolmage/Globe geometry)
2. Add a child container to the newly created container with a geometry and the VWPosition

plugin
3. Changing the longitude/Ilatitude will update the position of the new container

16.1.2 VWMousePosition

Can be used to translate a Mouse position into a longitude/latitude coordinate.
To use VWMousePosition

1. Add a geo-referenced map on a container (using Geolmage/Globe geometry)

2. Add a child container to the newly created container with a geometry and VWMousePosition
plugin

3. Click the E button (events button next to the Scene Editor)

4. Click on the map and see that the new container moves to the coordinate

16.1.3 VWNavigatorControl

Can be used to get or set Navigator values.
To use VWNavigatorControl

1. Create a Navigator scene

2. Under the scene’s GeoReferenceMap container, add a new container with a
VWNavigatorControl

3. Clicking the Update Geo Ref Data button will read navigator current values

4. Changing one of the plugin’s fields will set Navigator values
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16.2 Best Practices

When using a geo-reference (VWGeoref) object it is best to use a class member that will be

initialized in the constructor or only when you would like to explicitly do a refresh, doing so on the
ExePerField will impact performance.

The scene object (VWScene) has to be initialized in the constructor and has to be freed on the

destructor, avoiding to do so will result a performance impact as Viz World’s memory consumption
will not be freed.

16.2.1 Example

class MyPlugin

{
private:
VWScene * m_pVWScene;
}
MyPlugin: :MyPlugin()
{
m_pVWScene = VWScene::AddVWSceneInstance(this);
}
MyPlugin: :~MyPlugin()
{
VWScene: :RemoveVWSceneInstance (m_pVWScene, this);
}
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17 Viz World Server REST Support

This section contains a list of searches and functionalities of Viz World Server that can be accessed
with a Representational State Transfer (REST) architecture using the atom protocol.

The Viz World Server has the following entry point:

http://<vizworldserver>:10301/Directory

This section contains information on the following topics:

Browsing Regions

Browsing Projects and Favorite Folders
OpenSearch Support

Place Finder

Specify a Bounding Box

17.1 Browsing Regions

Viz World Server allows browsing regions (e.g. administration levels country, admin1, admin2) by
returning a feed that represents each region and contains entries for each sub-region (or if none,
entries representing towns in that region).

Each entry contains an atom description of the region, a link to its feed, links to towns contained
in that region, a link to a map of the region (using the Place Finder functionality shown later) and
an XML representation that is used by the Viz World clients.

17.1.1 URLs

The below URL is the main URL that returns a feed of all countries.

http://<vizworldserver>:10301/Browse

The below URL is an example region URL that returns a feed containing an entry for each sub-
region of the queried region. If no sub-regions exist, a list of towns in that region will be returned.

http://<vizworldserver>:10301/Browse?i1d=91296a0a00000600

17.1.2 Parameters
The following describes the main fields (XML tags) of each entry:

Id: Viz World database unique id of the region/town.

- Title: Viz World database name of the region/town.

- Summary: http text containing feature details - thumbnail, feature type, name, link to map
(using Place Finder URL), link to major/minor/both towns of the region (if exists).
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Content: Contains an xml representation of the feature, containing information like long/lat,
full region description (i.e. “Paris France” for Paris), feature type and more information that
the querying application might need.

Link (down): Contains the same link as the link (alternate). Required by Viz FeedBrowser.

Belgium
18:22 2010 "2 OF W O

Cavntry

Get Image
See Towns: 13 Major Towns

The summary (depicted above) is displayed in browsers like this (circled in red). For more
details, see the XML Example below.
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17.1.3 Example

<entry>
<id>1000000000001200</id>
<title type="text">Belgium</title>
<summary type="html">&lt;table&gt;&lt;tr&gt;&Lt;td&gt;
&lt;img src="http://<vizworldserver>:10301/FeatureThumbnail/?
feature=Country"&gt;&lt;/td&gt;&1lt;td&gt;Country&lt;br&gt;&lt;a href="http://
<vizworldserver>:10301/PlaceFinder/?Search=(null)"&gt;Get Image&lt;/
a&gt;&lt;br&gt;See Towns:&lt;a href="http://<vizworldserver>:10301/Browse/?
id=71f2d1c100001200&amp;filter=Capital,Town 1m,Town 100k"&gt;13 Major Towns&lt;/
a&gt;&lt; /td&gt;&lt; /tr&gt;&lt;/table&gt;</summary>
<updated>2010-07-07T15:22:39Z</updated>
<author><name>VizWorldServer</name></author>
<thumbnail url="http://<vizworldserver>:10301/FeatureThumbnail/?feature=Country"/>
<link rel="up" type="application/atom+xml;type=feed" href="http://<vizworldserver>:
10301/Browse/"/>
<link rel="self" type="application/atom+xml;type=entry" href="http://
<vizworldserver>:10301/PlaceFinder/?Search=Belgium"/>
<link rel="alternate" type="application/atom+xml;type=feed" href="http://
<vizworldserver>:10301/Browse/?id=71f2d1b900001200" />
<link rel="down" type="application/atom+xml;type=feed" href="http://<vizworldserver>:
10301/Browse/?id=71f2d1b900001260" />
<content type="application/atom+xml;type=feed">

<MapFeature>

<FeatureID>1000000000001200</FeaturelID>

<Name>Belgium</Name>

<DBName>Belgium</DBName>

<AlterName>Belgium</AlterName>

<Type>Country</Type>

<GeoPoint>4.466875, 50.259453</GeoPoint>

<Diameter>280.409729</Diameter>

<FullDesc>Belgium</FullDesc>

</MapFeature>
</content>
</entry>

17.2 Browsing Projects And Favorite Folders

Viz World Server allows browsing the folders of projects (tpl files) and favorites (cxp files) that are
stored in the browser.

A folder feed contains an entry for each sub-folder and project/favorite contained in the folder.

A project feed contains an entry for each stylesheet contained in the browser. A favorite link and
project-style link returns an image of the favorite/style.
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17.2.1 URLs

http://<vizworldserver>:10301/ProjectsFolder/
http://<vizworldserver>:10301/FavoritesFolder/

Each favorite/project/style entry also contains a thumbnail tag that contains a URL of a thumbnail
image of the project/favorite/style for use by Viz FeedBrowser. The thumbnail URL is also included

in the summary of the entry, for use by browsers.

17.3 OpenSearch Support

Viz World Server supports using OpenSearch to search features in the server database, plugins and
web.

17.3.1 URLs
OpenSearchDescription URL:

http://<vizworldserver>:10301/0penSearchDescription

OpenSearch template:

http://<vizworldserver>:10301/0penSearch?q={searchTerms}&pw={startPage?}
&visible={viz:visible?}&filter={viz:filter?}&source={Internal/All/MapDB/ExtraData/

Web?}

Example URLs:

http://<vizworldserver>:10301/q=Paris&filter=Capital&source=MapDB
http://<vizworldserver>:10301/q=Salem&filter=Town 10k

17.4 Place Finder (Server)

Viz World Server allows receiving maps of locations/features, in the same way as the Place Finder
plugin. This can be used by Escenic or any other web application, or for demonstrations of Viz

World.
Example URLs:
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http://<vizworldserver>:10301/PlaceFinder/?
Longitude=40.0&Latitude=40.0&FrameMapBy=Country&AddRegions=Full
http://<vizworldserver>:10301/PlaceFinder/?
Search=USA&MapWidth=1000&MapHeight=500&AddSearchLabel=1

17.4.1 Parameters

Most parameters are taken from the configuration server (and stored in registry). Upon first use (or
if missing in registry) the default values below are used. For parameters that are not stored in the
registry, use the default values below.

ProjectName: Desired project (default is VizDefProject.tpl)
Style: Desired stylesheet
MapWidth: Sets the width of the map (default is 512)
MapHeight: Sets the height of the map (default is 512)
Longitude, Latitude: Defines the center of the map if Search is empty (default is 0.0, 0.0)
Search: Desired feature name

- AddSearchlLabel: If search is used, adds the found label to the map.
DefaultMapSizeDeg: Size of map to be retrieved in degrees (used when FramMapBy =
DefaultMapSize)
FrameMapBy: Can be DefaultMapSize, Country, Admin1, Admin2 or Search
PlaceText: Add text label to map (if not empty)
FullDescription: Displays full-description feature labels (i.e. “Paris France” for Paris)

- AddRegions: Can be Disabled, FrameOnly, FrameAndBelow or Full
Returnimage: 1 for image (default), O for representing xml

17.5 Specify A Bounding Box

With this feature, users can use the rest APl to return map features within a specific bounding box.

17.5.1 URL
Base URI

http://<vizworldserver>:10301/Browse?" class="external-link">http://<vizworldserver>:
10301/Browse?

URL Template

http://<vizworldserver>:10301/Browse?left={value}&right={value}&bottom={value}
&top={valuel&filter={FilterTerms}&maxAnswers={value}

Parameters

Bounding box values:
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left, right, bottom, top, or
- west, east, south, north
Filter:
all
Capital
Town 1m
Town 100k
Town 10k
Town 1k
Town
Tourist Attraction
Reserve Or Park
Region Name
Physical Area Name
Physical Water Name
River Name
Mountain Name
Region Capital
MaxAnswers: (optional) default 500

17.5.2 Examples

Viz World User Guide - 17.0

http://<vizworldserver>:10301/Browse? left=0&right=0.5&bottom=51&top=51.5&filter=Town

10k, Town 1k

http://<vizworldserver>:10301/Browse?left=0&right=0.5&bottom=51&top=51.5&filter=all

http://<vizworldserver>:10301/Browse?
left=-2&right=1.5&bottom=51&top=55.5&filter=River Name

http://<vizworldserver>:10301/Browse? left=0&right=0.5&bottom=51&top=51.5&filter=Town

10k, Town 1k&maxAnswers=50
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18 Viz World Classic

T ol DM

This éhaipfer intfoéluc-es-Vi-z World Classic (VWC) which is the classic design tool for map templates
used by the Viz World Client (WoC) and thereby Vizrt’s control applications. Viz World Classic is an
alternative to Viz World Client’s Map Designer.

& Note: This chapter will not cover all aspects of map design using Viz World Classic;
however this chapter will explain important elements to note when creating a basic map
template using Viz World Classic.

Viz World Classic is a design tool with a database back-end, used for the creation of branded
maps. By extending it with a server, it can provide real-time, branded map imagery to several
clients embedded within Vizrt’s control applications. Templates created using Viz World Classic or
the Map Designer can be dynamically accessed through Vizrt’s control applications using the WoC.

Viz World Classic has access to a comprehensive vector based database that includes regions,
cities, roads, rivers, and so on. The vector data is supplied to Vizrt under license from
Bartholomew Mapping (a division of Harper Collins publishers). VWC also includes global 1Tkm
relief data in the DEM (Digital Elevation Model) format. The DEM data is provided by the United
States Geological Survey (USGS). Essentially, VWC uses the best mapping data available and is a full
animation and compositing system.

This section contains information on the following topics:

Project Template

Styles Editor

Markers

Map Projection

Map Position and Project Area Offset
Layer Stack and No Animation

See Also
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Map Designer
- Viz World Classic User Guide

18.1 Project Template
It is good practice to place all template (TPL) files in a single static location.
The recommended location is:

32 bit: C:\ProgramData\Curious Software\Curious World Maps\Users\Default\Projects
- 64 bit: C:\ProgramData\vizrt\Viz World\Users\Default\Projects

This folder and any sub-folders are automatically scanned for TPL files when the Map Server is
launched.

& Note: The template location should be exactly the same on Viz World Server and any Viz
World Classic design systems. If the paths are not identical it may well break the link to
any image elements, e.g. Markers.

18.1.1 To open a project template

1. Select Open... (CTRL+O) from the File menu.
2. Select Project Template (*.tpl, *.tpt, *.cgt) from the Files of type drop-list.
3. Select the template file and click Open.

18.1.2 To save a project template

1. Select Save (CTRL+S) from the File menu.
2. Select Project Template (.tpl)* from the Save as type drop-list.
3. Enter a filename, and click Save.
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18.2 Styles Editor
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Using the Viz Curious Maps (CM) Styles Editor, users can choose to modify an existing default Style
Sheet or create a new one.

The user has the ability to define and fully customize all of the available map data elements via the
CM’s Styles Editor. For example, the user can set region colors, select any font (TrueType only),
assign any static image (images with alpha are supported) as a marker, modify shadow settings,
change relief scale and lots more!

The map Style Sheets defined within the CM Styles Editor are then saved as Project Templates (TPL
files). Each Project Template can include any number of Style Sheets. These Project Templates can
then be accessed via Viz World’s Map Editor (WME) within other Vizrt products, such as Viz Artist,

Viz Trio, Viz Pilot, and so on.

18.3 Markers

Many users work with customized Markers; hence, image files can be imported to Viz World
Classic (VWC) from any location. VWC will create a Relative or Absolute file path to the actual
image file (depending on its distance from the TPL). If VWC cannot locate an image file it will
replace it with a ‘missing material’ red X.
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Athens
Airport

It is good practice to place all Markers in a single static location, as opposed to multiple folders on
a local computer and/or network.

The default location is:
32 bit: C:\Program Files\Curious Software\Curious World Maps\Markers
64 bit: C:\Program Files\vizrt\Viz World\Markers

& Note: When exporting a map related Viz Artist scene archive it is important to also
include the TPL files and any referenced image files (used for Markers, and so on).

18.4 Map Projection
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An essential setting for 3D globe building in Viz Artist is To set the map projection to an
equidistant cylindrical projection (also known as equi-rectangular or geographic projection). When
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using the map on a 3D globe in Viz Artist it will give the right (or more correct) representation of
the world.

& Note: In Viz Artist vertex mapping should be used when creating 3D globes.

18.4.1 Wrong and correct projection

Using the wrong projection within Viz Artist, for example, with the Map Tiler plugin to build a 3D
globe, will produce a distorted projection.

18.4.2 To set the map projection

1. Select the Properties tab.

2. From the Projection drop-list select the Cylindrical Equidistant projection.

3. Select “The World” from the View drop-list (lower-right corner) to check that the map is a flat
and not a globe view of the World.

4. Click Apply.

& Note: This test also works well via the WME in Viz Artist, and so on.

18.5 Map Position And Project Area Offset

Within Viz World Classic (VWC) there are two sizes to be aware of, the Project Size and the Map
Size. Both of these sizes have their own specific purpose and can have different values; however, if
the sizes are different or if the Map Position does not match the Project Area exactly, the map will
not look right when used in Viz Artist, Viz Trio, Viz Pilot, and so on. Even a minuscule offset will
break the map.

& Example: The Map Rectangle Tool (on the vertical toolbar) allows the user to freely move
the map around and can easily move the map out of position.
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To avoid the issue entirely, one should delete the Map Layer and add a new one. This automatically
adds a map that fits the current Project Size, but note that it will be using the Globe projection and
requires correction.

18.5.1 To set the project size

1. Select Project Settings from the File menu.
2. In the Project Settings dialog box set the Width and Height parameters.
3. Click OK to confirm the new project settings.

18.5.2 To set the map size

1. Select the Properties tab on the Properties panel.

2. Select the Transform options, and set the same Size (X and Y) that was used To set the
project size.

3. Press Enter to confirm and update the map.

18.5.3 To add a new layer

- Select Add Layer > Map from the Layer menu.

18.6 Layer Stack And No Animation

To avoid problems with the template (TPL) file, it is good practice to ensure that only one layer is
present in the Layer Stack. It is also important to remain at frame 1 in the timeline and refrain
from adding any animation keyframes.
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19 Frequently Asked Questions

This section contains some of the frequently asked questions concerning the use of Viz World
Client and Server.

I can connect Client A to the map server, client B is able to ping the map server, but Client B still
has no connection to the map server. What is wrong?

Sometimes, a machine is not accessible to all other computers in the network by its
hostname.

For example, if there are two clients, Client A & Client B, and the Viz World Server and the
Server Allocator running on the MapServer machine, Client A might resolve MapServer to the
IP192.168.1.100, but Client B might not resolve it to the same IP, or might not resolve it at
all because ClientB is on another subnet or for any other given reason.

Both clients can access the MapServer if it was defined as 192.168.1.100 or
MapServer.company.domain.

A frequent problem is therefore that users might write in Client B’s Viz Config the IP
192.168.1.100, and in Client A’s Viz Config MapServer (because that is the address each can
resolve); however, this will result in that the Server Allocator will return to both clients the
same hostname that was specified in the Server Launcher Configuration tool and therefore
only accessible to ClientA.

In other words, in the field of ControlledMapServer, the hostname/IP that is specified has to
be known to all clients and the Server Allocator machine.

I have problems loading my map scenes in Viz Trio?

Map scenes often use a large amount of texture memory; hence, this will take time to load
and might cause Viz Trio’s local preview channel to time out.

In Viz Trio it is possible to adjust the Viz Engine Connection Timeout for the local preview
channel.

Click the Config button, and under the Miscellaneous section select Local Viz Renderer, and
set the Viz Engine Connection Timeout parameter.

& Note: There is no such setting for the Viz Pilot client as the Viz Pilot client itself does host
the Viz process for local preview

What are the Digital Globe proxy and firewall configuration settings?

If you need to use a proxy, remember to set your Proxy Server settings.

All communication to Digital Globe servers goes through https to
services.digitalglobe.com because https encrypts the entire request (i.e. both header and
body) .

Ask your IT department to allow communication to the following Digital Globe server
address: 205.166.175.85.

See also Digital Globe cache settings.

What are the Microsoft Bing Maps proxy and firewall configuration settings?

If you need to use a proxy, remember to set your Proxy Server settings.
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All communication to Microsoft Bing Maps servers goes through http (SOAP and regular
HTTP GET) on port 80.

Any sub-domain of virtualearth.net should be

accessible to the Viz World Server and Viz World Classic application. For example:
dev.virtualearth.net, t1.tiles.virtualearth.net, t3.tiles.virtualearth.net etc.

See also Bing cache settings.

The server cannot find the dongle

Run as administrator.

Make sure you are not using Windows Remote Desktop. Instead, you can use Remote VNC or
Team View.

Are orthographic cameras supported?

Orthographic cameras are not currently supported by Viz World.
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